
GET CREATIVE WITH 
YOUR iPHONE X

Create new
iCloud events

Mac  iPad  iPhone  Watch 2GBOF FREE
DOWNLOADS

MANAGE YOUR WATCH NOTIFICATIONS | CONSERVE YOUR iPHONE DATA | USE AN iPHONE HOTSPOT

KICK-START

2018
APPLE

Get fit with your iPhone, make your Mac
run faster and get the most out of iOS apps!

TIME TRAVEL  
WITH YOUR  
APPLE WATCH
MANAGE YOUR
APPLE TV STORA
10 WHATSAPP
SECRETS
CREATE YOUR OWN
iPHONE RINGTONES

50
PAGES OF  
TUTORIALS

OVER

How to master Apple’s
audio streaming service

Set up a shared
family calendar

run faster and get ther most out of iOS

AGE

MUSIC

WITH





Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Instagram
icreate_mag

Email
icreate@futurenet.com

Welcome

Roland Waddilove
This month Roland has had Mail on his mind 
as he showcases the best new features to 
land in Apple’s premier email suite courtesy of 
macOS High Sierra.

Shaun McGill
This month, Shaun has been burning off 
seasonal timber with his iPhone and he 
shares all of the built-in features and third-
party apps for best helping you get in shape.

George Cairns
Our creative expert provides a round-up of 
useful tips for Final Cut Pro X to help speed 
up your workflow and he also shows you 
how to travel through time in iMovie.

Meet the experts

“You’re in the right place to learn how to 
get the most out of your Apple devices”

 iCreate 181

An exciting new Apple year is upon us and if you were 

lucky enough to receive the gift of an Apple product 

over the holiday period then you are in the right place to 

learn how to get the most out of your new device. In 

fact, you may be heartened to learn that you can use 

your iPhone to help you get fighting fit for the year 

ahead and this month we reveal all of the best built-in 

features and third-party apps to help you do just that.

We also showcase Apple Music, the brilliant 

subscription service that lets you stream over 40 million 

songs, dip into expertly-curated playlists and share 

music more easily than ever with your family and 

friends. And, as the coming months are likely to be 

packed full of exciting events, we thought we’d 

demonstrate just how easy it is to create an iCloud-

powered calendar that you can share amongst family 

members that they can all edit and add to – it’s the 

perfect way to keep everyone together. All that plus the 

usual tutorials to get the most out of iOS 11 and macOS 

High Sierra should set you up well for 2018! 

Ryan Butt Editor
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#Trending

If you’re a big
fan of Apple’s
launch events,
you could be
forgiven for

wondering if they meander
on for too long, especially
when the clock ticks past the
two-hour mark and you’re still
waiting for the big ‘one more
thing’ announcement. The

The new Apple Heart Study launches to identify irregular 
heartbeats, the biggest cause of strokes in the US

Apple set to push 
medical boundaries  
in 2018

“Doctors can use the iPhone and Apple
Watch to produce insights into conditions
like autism and Parkinson’s disease”

Apple has been partnering its 
products with some huge  
names in the medical world…

indulgent, when CEO Tim Cook 

to show how well his company 
is doing. Sometimes, though, 
Apple hides a few hidden gems 
in those early stages. 

They might not have the 
razzmatazz of a new iPhone 
reveal or a long-awaited Mac 
refresh, but these hidden  
gems really should make 
headline news. Apple is 

8

doing amazing things in 
medical science, for example, 
partnering its products with 
some huge names in the 
medical world to show that 
technology really can be a 
power for good.  

Apple’s ResearchKit, 
a software tool used by 
developers to create apps 
that conduct medical studies, 
has already revolutionised 
traditional medical study. 
Doctors around the world 
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can use the iPhone and 
Apple Watch to produce 
insights and discoveries about 
conditions like autism and 
Parkinson’s disease. To date, 
the ResearchKit and CareKit 
platforms have been used by 
over 500 researchers and more 
than three million participants. 
And now the Cupertino tech 
giant has launched a new app, 

its-kind research study using 
Apple Watch’s heart rate sensor 
to collect data on irregular 
heart rhythms and notify users 
who may be experiencing atrial 

An irregular heartbeat is the 
leading cause of a stroke and 
leads to 130,000 deaths and 

countless other hospitalisations 
each year in the US. The 
problem is, most sufferers 
don’t even know that they 
suffer with the condition – and 
that is where Apple and its 
amazing smartwatch come in. 

“Every week we receive 
incredible customer letters 
about how Apple Watch has 
affected their lives, including 

These stories inspire us and 
we’re determined to do more 
to help people understand  
their health,” says Jeff 
Williams, Apple’s COO. 
“Working alongside the medical 
community, not only can we 
inform people of certain health 
conditions, we also hope  

to advance discoveries in  
heart science.”

The technology that enables 
the Apple Watch to be a 

To calculate heart rate and 
rhythm, Apple Watch’s sensor 

hundreds of times per second 
and light-sensitive photodiodes 
to detect the amount of blood 

The sensor’s unique design 
gathers signals from four 
different parts of the wrist, and 
when combined with powerful 
software algorithms, Apple 
Watch isolates heart rhythms 
from any other type of noise. 
The Apple Heart Study app 
uses this technology to identify 
an irregular heart rhythm.

22 to take part and live in the 

in the background, recording 
how many days you’ve been 
involved in the study and 
how many heart rhythm 
contributions you’ve supplied. 
This will depend on how active 
you are during the day, so 
Apple Heart Study may take 
more than one contribution 
throughout the day. If an 
irregular heartbeat is detected, 

as well as a free consultation 
with a doctor who is part of the 
study and an electrocardiogram 
patch for further monitoring.

Apple is partnering with 
Stanford Medicine throughout 
this breakthrough trial. Stanford 
believe that the trials like this 
could have a huge impact on 
the future of medical science – 
and given the sheer volume of 
likely participants, it’s hard not 
to agree. “Through the Apple 
Heart Study, Stanford Medicine 
faculty will explore how 

technology like Apple Watch’s 
heart rate sensor can help 
usher in a new era of proactive 
health care central to our 
Precision Health approach,” 
says Lloyd Minor, Dean of 
Stanford University School 
of Medicine. “We’re excited 
to work with Apple on this 
breakthrough heart study.”

Open-source software  
tools like ResearchKit and  

apps like Apple Heart Study  
do not have a business 
model, and Apple should 
be applauded for that. Born 
out of a wish to make a 
difference to society, they are 
not a money-making tool or a 
public relations spin. Whether 
Apple products can help 
cure diseases and transform 
medicine for forever is another 
matter. Only time will tell, but 
rest assured, Apple is doing 

medical science and it will 
continue to do so into 2018 
and beyond.The app uses Apple Watch’s 

heart sensor to collect data and 
will notify users who may be 
experiencing atrial fibrillation

Apple Watch uses a combination 
of flashing LED lights and light-
sensitive photodiodes to calculate 
heart rate and rhythm.

“Light-sensitive photodiodes detect the 
amount of blood flowing through the wrist”



Things we learned 
this month

Apple and (RED) announce  
record fundraising    Apple

Celebrating a record year of 
fundraising, Apple and (RED) 
announced on World Aids Day 
that they have raised over 

$30 million for the Global Fund in 2017. 
This equates to 144 million days of ARV 
medication that prevents the transmission 
of HIV from mothers to their unborn 

babies. “Apple’s commitment to the AIDS 
fight is unparalleled. It’s not just the $160 
million raised for the Global Fund that has 
impacted many millions of lives, it’s their 
ability to bring heat, awareness, energy 
and eyeballs to keep this issue front and 
centre,” said Deb Dugan, CEO, (RED). 
“Their support cannot be underestimated.”

Apple has unveiled its end-of-year charts, revealing
the most popular apps, music, movies, TV shows, 
books and podcasts across the App Store, Apple 
Music, iTunes, iBooks and Apple Podcasts. On Apple 

Music, More Life by Drake was awarded Album of the Year, while 
Ed Sheeran’s Shape of You won Best Track honours. Mindfulness 
app Calm was the 2017 iPhone App of the Year, while image 
editor Affinity Photo landed the iPad prize. Moana was top iTunes 
movie, and Game of Thrones walked away with the TV honours. 
Margaret Atwood’s The Handmaid’s Tale was the most read book. 

Apple reveals most popular 
downloads in 2017   Apple

#Trending
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Apple had another big month of coding news, offering
thousands of free Hour of Code lessons, introducing
a new educational challenge in its Swift Playgrounds
app and adding new teacher resources to its Everyone

Can Code initiative to help teach Swift, Apple’s easy-to-learn
programming language. For the fifth year, Apple Stores hosted daily
coding sessions in celebration of Computer Science Education Week,
introducing the basic principles of coding to young people all over
the world. Students over the age of 12 were even invited to use the
new feature in Swift Playgrounds that lets you build and customise a
digital robot. In our youth we had to make do with Bigtrak…

Security bug  
hits macOS  
High Sierra

Apple was forced to send out 
an emergency fix for macOS 
High Sierra users after it 
emerged that there was a 
serious security flaw where 

anyone was able to access locked settings 
and sensitive data using the username ‘root’ 
and no password, and subsequently bypass 
the login screen. No older versions of macOS 
or OS X were affected. 

The security bug gained high profile 
attention, including from Edward Snowden, 
who commented: “Imagine a locked door, but 
if you just keep trying the handle, it says, ‘oh 
well,’ and lets you in without a key.” 

“Security is a top priority for every Apple 
product, and regrettably we stumbled with this 
release of macOS,” Apple says. “We greatly 
regret this error and we apologise to all Mac 
users. Our customers deserve better.” An 
update has subsequently addressed the issue.

“Security is a top priority 
for every Apple product, 
and regrettably we 
stumbled with this 
release of macOS”

Free coding lessons at all 
Apple Stores   Swift Playgrounds

Amazon Prime arrives on Apple TV   
Apple TV

It was announced several months back but Amazon’s entertainment 
subscription service Prime has finally been made available for Apple TV, 
and is now supported in over 100 countries. You can now watch Prime 
Original Series like The Grand Tour and The Marvelous Mrs Maisel. 

“Amazon Prime Video is one of the most eagerly anticipated apps to come to Apple 
TV, so we’re excited to bring all of that great content to customers,” says Eddy Cue, 
Apple’s senior vice president of Internet Software and Services. The long-awaited 
Apple TV app has also gone live, giving fans in the US a seamless way to keep track 
of their favourite teams and games in real time. 
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This month we thought we’d celebrate the Dock – that strip of
icons at the bottom of your Mac or iOS screen that provides quick
and easy access to all of your essential apps. On iOS your Dock
remains an ever-present regardless of which home screen you are
on and on Mac you can customise it to appear when you want, 
where you want on the screen and apply additional special effects 
when you minimise windows or open apps. All hail the Dock!

MINUTE PROJECTS
TO TRY TODAY

3

1 2

#Trending

The Dock is an
ever-present 
on all of your 

iPhone home screens, so 
it makes sense to have 
your most-used apps in 
pride of place there. Here 
we show you how to add 
and remove apps from 
your iPhone Dock.

The iPad was
the device that
benefited most

from the iOS 11 update
as advancements were
made to the touchscreen
interface to make it more
akin to a laptop. Here
we show you how to use
Split View from the Dock.

1  Move apps  
to your Dock

2 Using Split
View on iPad

1 Press 
and hold
To start making 
changes to 
your iPhone 
Dock, simply 
press and hold 
on any app icon 
for a couple of 
seconds and 
then the app 
icons will begin 
to shake on the 
iPhone screen.

2 Drag and 
drop icons
When the 
app icons are 
shaking, press 
and hold on the 
one you would 
like to add to 
the Dock and 
then drag it in. 
You can have 
a maximum of 
four apps in 
your Dock.

3 Click  
to finish
Once an icon 
has been 
added to the 
Dock, drag it 
left or right to 
order the apps 
and then when 
you have finish 
click the Home 
button. Repeat 
the process to 
remove apps.

1 Drag and drop
Press and hold on an app icon in your
Dock and then drag it up to the far-left
on the main home screen – a black 
area will appear for you to drop it into,
after which it will fill half the screen.

2 Drag a second app icon
Keeping the first open app in place 
with one finger, you can then drag a 
second app up to fill the vacant space
on the right, after which both apps can
be viewed side by side.

3 Make adjustments
If you want to adjust how much space 
each app gets on your screen, simply 
press and hold on the screen divider 
and then drag it left or right. It’s a 
fabulously intuitive system.

Unlike your iOS
devices, your 
Mac Dock has its 

own dedicated settings
in System Preferences.
By going there you will be
able to adjust the size, the
magnification of the app
icons and much more to
make it your own.

3  Customise 
your Dock

1 Open System Preferences
Go to System Preferences>Dock and
then click and hold on the Size slider
to adjust the size of the Dock as it
appears on your desktop. You can also
click to magnify the app icons.

2 Dock positioning
You can actually position the Dock
where you want on your desktop,
such as the side – simply click ‘Left’,
‘Bottom’ or ‘Right’ and the Dock will
be placed accordingly.

3 Special effects
Other options apply to the effects that 
occur when you minimise windows to 
the Dock (‘Scale’ or ‘Genie’) or open 
apps from the Dock. You can also hide 
the Dock when not in use.
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Just a few years ago the best we could
hope for when trying to lose weight 
or get fitter was to be able to track 

how many steps we took each day. Simple 
fitness trackers offered a way to focus on 
movement, but the reality was that they 
could not help in a way that offered real-
world benefits to the individual. 

Over time that has changed and we now 
have smart watches and fitness trackers 
that can monitor sleep, heart rates, calories 
expended and consumed, and even the 
exact routes you take on a daily basis. 
This level of tracking is extremely useful, 
but it would be of little consequence 
without the ability to analyse the data and 
to view the trends and improvements on 
a larger screen. This is where the iPhone 
comes in because all of the major fitness 

organisations make trackers that are
compatible with it and there are apps that 
push the limits of what we thought possible 
not so long ago. It all comes together in 
Apple’s Health app which is a dashboard 
for every important aspect of your health 
and it works to produce a detailed and 
understandable view of how you are 
improving and ultimately how fit you are. 
There is virtually no important area that is 
not covered and with some knowledge and 
a couple of accessories you really do have 
everything you need to lose weight, get 
fitter and improve your lifestyle.

When it comes to deciding what will 
work for you among the myriad of options 
available, try not to just look at Apple 
products. You should take your time to 
see what’s out there and also check with 

friends to gauge their experiences. There is
no one accessory or software solution that 
works for everyone so be realistic with your 
goals and then make an informed decision, 
which we hope to be able to help you 
with. We will take you through the benefits 
of the latest trackers and also show you 
how to track specific health points with 
a focus on offering advice that should 
translate into real benefits to your health. 
The iPhone and the Health app, however, 
are integral to monitoring fitness and there 
is no doubt that these two are able to work 
with multiple solutions to produce what is 
likely the very best tool for the job available 
today. Remember though, you will need to 
put the effort in as well because all of the 
tracking in the world will not work without 
perseverance on your part.

GET FIT WITH  
YOUR iPHONE

How to use iOS to improve your fitness, burn off  
that fat and get in shape for 2018



HOW TO SET UP
APPLE HEALTH

1. Your
Medical ID
Tap the ‘Medical ID’
icon at the bottom
of Health and enter
as much information
as you can. When
someone finds your
phone in an emergency,
they can view it.

2. Four
main areas
Under ‘Health Data’ you
will see four areas that
are tracked. Tap each
icon to see what is
beneath and what you
need to do to track your
health and fitness.

3. Track
your steps
Once you have allowed
Health to track your
motion, your steps will
be shown in ‘Activity’.
Remember that you
may not always be
carrying your phone
with you so some may
be missed.

4. Choose
your sources
In ‘Sources’ you can
see which trackers are
used to add data to
Health. Some may need
intermediary apps, but
we will show you how
to set those up as well.

5. Check
everything
With access granted
for Health to monitor a
third-party tracker, you
will be able to monitor
sleep, your heart rate
and a whole host of
other important data
every day.

1

2

3

4

The Apple M-series coprocessors
that are built into the later iPhones
are designed to work in a similar way
to fitness trackers when it comes to
monitoring your movements. When
paired with Apple Health, you actually
have a basic fitness tracker for free
that can track the important health
data you need.

5
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“The iPhone and the  
Health app are integral  
to monitoring fitness”



Give Health permissions
Health is focused on collecting your data which 
can come directly from the iPhone’s processors or 
from other apps to help build up a general picture

of your health. This means that some permissions
will be required to allow it to work as you need it
to, but the process to do this is incredibly easy.

1 Capture 
the motion
Go to Settings> 
Privacy>Motion & 
Fitness and enable 
‘Health’. Also 
enable ‘Fitness 
Tracking’ at the top 
of the screen to 
capture all possible 
data points.

2 Manage 
health apps
Tap the ‘Sources’ 
icon and then a 
listed app to find 
out what access  
it currently has. 
Most will likely ask 
for permissions  
as soon as they  
are installed. 

3 Manage 
your data
Go to ‘Sources’ 
again and scroll 
down to see all 
connected devices. 
Check the data 
that is stored and 
delete if you have 
any concern about 
what is held here.

app displays them all cleanly.

 Drink to live
You can also input 
your water intake 
at regular intervals 
throughout the day. 
This is an area that few 
consider when they are 
busy, but water intake 
is vital when losing 
weight and improving 
your overall fitness.

 Sleep tight
The advanced trackers found in 
many smart watches and fitness 
products can track your sleep 
patterns. You need enough sleep to 
power through your exercises.

sleep over time.

Count all aactivitiesa
The Fitbit trackerss count thes
distance you travel, the floors youe
climb, the minutes you exercises
and the calories you expend toy
give a complete view of yourv
general activity levels. The iPhone v
app displays themm all cleanlym

I e heartn the
oosing aWhen choo
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iPhone,with your
advisewe wouldd

sure thatyou to ens
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riestrack caloo
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Get fit with your iPhone

Monitor your entire body
Certain fitness companies, such as Fitbit, 
offer apps that let you monitor way more 
than just the steps you’re taking each day. 

From calorie output to exercise to your 
exact heart rate, you now have the ability 
to monitor your fitness in just one app and 

it takes just seconds to keep every section 
updated, so you can keep on top of it 
even during the busiest of days.



Trends are key to success
Most fitness apps and 
trackers offer huge amounts 
of data that can be used  
to track activity, your heart 
rate and everything else,  
but it is important to 
understand that the 
numbers themselves are 
not the main factor. It has 
been proved that different 
trackers provide different 
results for the same 
people and there really is 
no way to avoid this until 
the technology becomes 

foolproof. However, 
when you are looking to 
lose weight or improve 
your fitness it will be the 
trends that matter the 
most. Whether a tracker 
is extremely accurate or 
only vaguely so, it is highly 
likely that it will track in the 
same way over time. This 
means that you can aim to 
improve in key areas and 
the results will offer enough 
encouragement to give you 
the impetus to keep going. 

1 Step it up
It takes time to build up your daily 
activity to the point that it feels 
normal, but a simple look at your 
growing movements will help you 
see how it is benefiting your health.

4 Easy visuals
Apple has taken the idea of tracking
trends to a new visual level, letting
you see successes in an instant.
Notice how the rings stand out on
days when all have been closed.

2 A close eye
The trends can also highlight areas, 
such as sleep or eating, where your 
health is potentially declining. Check 
the data and consider the factors 
contributing to the decline.

5 Let it happen
Enter water and food consumption 
and let the app do the rest. Over 
time you will see a buildup of your 
activities and diet so you can see 
how you are improving.

3 In and out
The visual nature of the graphs
within many fitness apps means
you can easily understand how your
diet changes over time and how it
effects your weight loss or gain.
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Get fit with your iPhone

Track your  
weight accurately
Historically we have relied on mechanical 
scales to gauge weight, but these are 
starting to give way to digital scales that 
can connect to Wi-Fi and then to an iPhone 
using a fitness app. The Aria scale from 
Fitbit is a very good example because it is 
easy to set up, even easier to use and the 
results embed perfectly into the Fitbit app.

1 Set it up
Go to fitbit.com/scale/setup and follow 
the instructions to set up the Aria scale. You 
should be up and running in minutes provided 
you have an active Wi-Fi connection it can 
connect to.

2 Weigh yourself
When you weigh yourself with bare feet, the 
scale will measure your weight, body fat 
percentage and your BMI. The results will be 
automatically logged within the Fitbit app on 
your iPhone.

3 Check the trend
Over time, this stat could become the most 
important to you as it evidences exactly how 
well your fitness regime is progressing. It’s 
informative and offers much encouragement 
to help you reach your goals.

18



“The app can
alert you 
to elevated 
heart rates”

Track every beat

Set up a  
new tracker

We are already at the point where 
the heart rate trackers in modern 
devices can display potential problems 
purely because they are tracking you 
all of the time. Whether you want to 
understand how it copes under stress 
or if unusual blips occur, you can 
have some extra peace of mind at a 
relatively low price.

When setting up a new fitness 
tracker or smart watch, you 
need to ensure that the goals 
you set are realistic and that 
the specific questions are 
answered as accurately as 
possible. It is tempting to 
give yourself easy goals and 
to tweak the settings in your 
favour, but that could result in  
a lack of progress so be 
sensible and the rewards will 
come to you.

1Reasonable 
reminders
Most trackers send 
fitness reminders 
throughout the day 
and the Apple Watch 
in particular can be 
relentless in this area. 
When you first set 
up the device, go to 
the Watch app and 
then select ‘Activity’ 
at which point you 
can choose which 
reminders to enable 
and how often they 
should appear.

1. A simple app
If you try an app such 
as HeartWatch and 
wear an Apple Watch 
you will be able to easily 
check your heart’s 
historic activity. The 
ranges are important for 
general health tracking.

2. Workout rates
The app can also  
track your workout 
rates and display them 
in a timeline. These  
are just as important 
and especially so  
when checking your 
heart fitness.

3. Timely alerts
You can also set the 
app to alert you to 
elevated heart rates. 
The cost of the Watch 
and app is a small price 
to pay for potential life-
saving benefits.

1

2

3

4 Weight loss
The balance between 
aiding progress and 
feeling discouraged 
can be narrow 
when you want to 
lose weight. Set a 
reasonable weight 
loss goal and then 
change it as your 
target comes closer. 

2 Set goals
In the Activity app 
on the Apple Watch 
press hard on the 
screen and a new 
menu appears. Tap 
‘Change Move Goal’ 
and set the calories 
you want to expend 
each day. Set an 
achievable amount. 

5 Big picture
Goals for sleeping 
and some other areas 
can go up and down 
on a daily basis. Think 
about the long-term 
view. It doesn’t matter 
if you only have five 
hours sleep one night 
if the average for that 
week is a lot higher.

3 Consider 
your lifestyle
Take time to 
think about your 
movements today 
and add goals that 
slightly stretch them. 
You will then need to 
tweak them to higher 
levels as your activity 
levels improve. 
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Get fit with your iPhone

1 Almost 24 hours
An Apple Watch can easily get you 
through the day, but what about the 
night? In our tests you can charge an 
Apple Watch for 30 minutes mid to 
late evening and it will run until the 
same time the next day.

2 Don’t do everything
Try to limit the number of apps you 
have installed on your Apple Watch 
and it makes sense to do the same 

with notifications. Just because
it is available does not mean tha
you need to over-complicate the
Watch experience.

3 Track your sleep
With sensible charging you shou
be able to use an app like AutoS
to track your sleep as well as yo
activity. Potentially, the Apple W
can be a fully-fledged fitness tra
that competes with the very be

at
e 

uld
Sleep
our

Watch
acker

Keep the Apple Watch running

Monitor your calories with the Fitbit app

We are already at the point where the 
heart rate trackers in modern devices 
can display potential problems purely 
because they are tracking you all of the 

time. Whether you want to understand 
how your heart copes under stress or if
unusual blips occur, you can have extra
peace of mind for a relatively low price

A fitness tracker when married to an advanced 
app can really help you to understand how the 
calories you take in and expend affect your 

body. It won’t take long to be able to use the 
data to make the adjustments you need for 
weight loss and improved fitness.

1

a
. 2

3

 The numbers
The numbers always tell the  
truth and success is simpler than 
you may think. If you expend 
more calories than you take 
in there is no reason why you 
should not lose weight over 
extended periods.

 Visual indicators
The graphs will help you to 
judge your calorie intake and 
expenditure compared to 
previous days in the week. When 
you tap the arrows at the top, you 
can see a much deeper overview 
of your dietary habits.

 Set your targets
Input the amount of weight you 
want to lose and the app will try 
to work out what you need to eat 
to help you achieve your goal. 
It’s a constant reminder of what 
you need to do to become lighter 
and fitter.

 What you eat
With accurate input, the Fitbit 
app can also show you how 
much fat, protein and carbs you 
are eating. Try to keep a healthy 
balance for the best possible 
results over time. You will feel 
much better for it.

“Potentially, the Apple  
Watch can be a fully- 

fledged fitness tracker”
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Challenge your friends
One sure fire way to put some spark into 
your new fitness regime is to challenge 
friends to see who can do the most 
exercise each day. Thankfully the Apple 

Watch and Fitbit solutions offer lots of 
options in this area and setting up the 
challenges is very simple. It could be just 
what you need to succeed.

“Sync Solver 
exports your 
Fitbit data
to the Apple
Health app”

Sync Fitbit 
with Apple 
Health

Apple Health, as we have explained, is 
designed to give you a full overview of 
your health and fitness, but it does not 
natively work with third-party products. 
There is, however, an app that can help 
which will allow you to automatically 
export your Fitbit data to the Apple 
Health app. It’s a simple solution that 
works very well.

1. Offer the 
permissions
Go to the App Store 
and download Sync 
Solver. When you open 
it you will be asked to 
allow some permissions 
in Apple Health. Make 
sure you enable all  
of them.

2. Time to sync
When you synchronise, 
all of the data stored in 
your Fitbit app will be 
sent to Apple Health 
so that you can get a 
wider overview of your 
progress. Simple.

3. Check it out
At any time you can 
check the historic syncs 
within the app. It is very 
reliable and should 
work as expected every 
single time without  
any problems.

ld a group
ed you know people using 
me fitness platform, there 
an option to add friends 
thin the challenges 
. Simply click and wait for 
vite to be accepted.

2 Real-time competition
You will be able to view their 
stats in real time which should 
give you the impetus to push  
that bit harder. However, try  
not to overdo it just to win  
the competition. 

3 Set your privacy
The ability to choose exactly 
what your friends can see will be 
available. They will need some 
stats to challenge you, but you 
do have the ability to customise 
the settings.

3

1

2

Health app
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Get fit with your iPhone

1 Apple Watch
We obviously have to start 
with the Apple Watch which 
is designed to work with the 
iPhone for many different 
tasks. It will help inspire 
you to get fit thanks to 
the superior sensors and 
intuitive fitness ring system 
that plays on the emotions. 
You will need to use  
third-party apps for  
some tracking, though.

2 Fitbit Ionic
Fitbit’s latest attempt at a 
smart watch ticks all of the 
boxes in terms of tracking 
your heart, your activity, 
calorie intake and all of the 
areas you need to monitor 
to get really fit. Practically, 
it works very well, but the 
‘Marmite’ design and lack  
of third-party apps do limit  
it in comparison to the 
Apple Watch.

3 Nokia Go
If you are looking for a less 
expensive tracker that still 
manages to track exercise, 
general activity, sleep and 
even swimming, the Go from 
Nokia is a decent choice. 
The style is very basic 
and there is no heart rate 
monitor, but the eight-month 
battery life is a definite 
advantage over much of  
the competition.

4 Fitbit Charge 2
Fitbit dominates the fitness 
tracker industry in terms 
of the number of products 
available and the Charge 
2 offers all of the tracking 
sensors you will need. 
When paired with the 
comprehensive app it  
offers all you need, but 
perhaps lacks a little when 
it comes to excitement and 
flexibility of usage. 

5 Garmin 
vívoactive® HR
This is the power user’s 
fitness watch which is 
capable of tracking all kinds 
of exercise on the high-
resolution colour screen, 
with an eight-day battery 
life for good measure. 
The aesthetics are ideal 
for those who like the 
fitness look, but a fashion 
accessory it is not.

The  

best fitness 
trackers
The iPhone is so popular that 
almost every fitness tracker 
and smart watch on the planet 
is compatible with it. The level 
of compatibility, however, 
varies and making the choice 
of which is best is far from an 
easy decision. Hopefully we can 
make the process a little easier 
for you by highlighting the highs 
and lows of the best available.
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best fitness apps
Your fitness tracker 
or smart watch will 
come with all of the 
software you need 
to keep it connected 
and synchronised 
with your iPhone, 
but you can expand 

the range of tracking 
with apps that will 
take your fitness 
regime to a whole 
new level. Here we 
aim to highlight some 
of the best that you 
may not be aware of.5

Fitbit 
Coach
Fitbit Coach 
is designed to 

help you tone all parts of 
your body and to raise your 
general level of fitness using 
exercises that require no 
extra equipment. If you have 
a few spare minutes each 
day you will benefit from the 
short workouts in as little 
as a month. The app works 
best when used with a  
Fitbit tracker.

Activity++
When using an 
Apple Watch 
it can take a 

few taps to gain a decent 
overview of how your 
movements and fitness 
are changing, but with 
Activity++ you get to see 
everything in a much wider 
view. It feels familiar in 
every way, but for some 
users it can make all of the 
difference to understanding
complex health data.

HeartWatch. 
Heart & 
Activity
Few apps offer 

such a potentially useful set 
of data as HeartWatch. You 
can see how your heart is 
beating when asleep, when 
waking up, during a workout 
and just going about your 
business. It offers the kind of 
results that can have hugely 
positive effects on all aspects 
of your life. It requires an 
Apple Watch to work.

MyFitness 
Pal
Limiting food 
intake to  

healthy amounts is of 
course crucial in getting 
fit. MyFitnessPal is likely 
the best tool to help you 
manage your calorie intake 
each day thanks to the 
efficient way it works and 
the clever way it presents 
the data back to you. It can 
offer all of the inspiration 
you need when dieting.

Sleep Cycle 
alarm clock
As you may 
know, sleep is 

vitally important for giving 
you the energy to get fit and 
for your general health, but 
it’s not as simple as just 
trying to get as much as 
possible. This app will wake 
you in your lightest sleep 
phase within a specified 
time frame and should help 
you to start your day in the 
most positive way possible.

“Expand the tracking with 
apps that take your fitness 
regime to a whole new level”



1 The Fossil Q
hybrid watch
The Fossil Q hybrid watches
work with an iOS app to
monitor your sleep and
steps during the busiest
or lightest of days. They
will also notify you when
calls and messages come
in, but still manage to retain
the traditional functionality of a
real watch and with no battery
charging for good measure.

3 Montblanc
e-Strap
If you want to continue wearing
a watch that is important to
you, but still want to track
your fitness you could
wear a tracker on the
other wrist. For added
elegance, however, you
could use the Montblanc
e-Strap which will track
your activity and provide
iPhone notifications within a
completely traditional look.

2 Fitbit Flex 2
The Fitbit Flex 2 is so small
that it can be worn as
a pendant as well as
on the wrist with the
use of an inexpensive
accessory. You still
get activity and sleep
tracking in a swim-proof
form with the ability to go
five days in between charges
as well. It also works perfectly
with the iPhone of course.

Hybrid solutions
When you attach a device to your body it
immediately becomes jewellery for many
people. This is why traditional watches
can cost so much and why the brand
is so important. To reflect this, you can
keep track of your fitness using traditional
products that take advantage of modern
technologies to keep you stylish and fit at
the same time.
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The future of 
fitness tracking
The technology employed in the fitness tracking sector has 
improved exponentially in the last few years and we are now in 
a position where the most important areas of general fitness can 
be tracked with great accuracy. Many of the devices are almost 
invisible when worn and they come with battery performance that 
also makes them practical to use even when you are away from 
power for an extended period of time.

Apple is generally considered to be at the forefront of health 
and fitness development, despite the fact that Fitbit makes more 
dedicated trackers than any other company. ResearchKit is a 
framework that lets iOS developers create tools that can be used 
for medical research. The data that is produced can be used for 
studies and research which will potentially lead to groundbreaking 
developments in the future. 

HealthKit is another tool that third-party developers can use to 
allow the reading and writing of their data to Apple Health. This 
gives the user the ability to view all of their health and fitness data 
in one place, and will once again grow to build up a repository of 
information that can be useful for doctors and anyone else in the 
medical profession. 

As the developments continue, we can reasonably expect for our 
blood to be monitored by a non-intrusive tracker or watch and with 
that will come the early detection of a variety of potential illnesses. 
Heart monitoring could reach the point where preventative alerts 
will be sounded way before the worst happens and the potential 
to track other areas such as our eyes, hearing and almost anything 
else feels within reach.

You will likely be able to use bespoke fitness and diet plans 
directly from your iPhone based on what the sensors see and 
preventable health issues could become a thing of the past as the 
technologies continue to improve and gain accuracy. We are just at 
the start of the health and fitness technology revolution and Apple, 
and by association the Apple Watch and iPhone, are well placed to 
lead the field into the future.

Get fit with your iPhone
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Don’t chase the numbers
In what is still a fledgling industry, 
there have been many tales of how 
people use fitness trackers and 
many of them have been negative. 
It is easy to get caught up in a new 
fitness regime and believe that the 
tracker or smart watch will somehow 
prove to be the key to success, but 
that is far from the case.

Around 95 per cent of your fitness 
and weight loss will come from you 
and a continual understanding of 
what ‘you’ need to do to achieve 
your goals. These trackers, and by 
association 
the iPhone, 
are designed 
to feed you 
information 
that you can 
use to improve yourself over long 
periods of time and as much thinking 
as physical exercise is needed to 
truly get to where you want to be.

Here are some top tips that you 
should follow to succeed when 
monitoring your fitness and weight:

Don’t set your goals too high or 
low. Think carefully about what 
you do today and aim for a steady 
improvement over time.

Never ever cheat. It is easy to skip 
adding food you have eaten or to 
add an exercise you have not done 
just to get to a target on your phone, 
but that is ultimately pointless. If 

you let the numbers become your 
main goal you are much more likely 
to fail – always think about what you 
are doing in the real world and not 
what’s on your iPhone screen.

Look for trends, not just numbers. 
If you are eating too much and eat 
less each day that is a good thing, 
and if you move around more each 
day that will offer benefits in the long 
run. Provided you are improving in 
the key areas you will be healthier 
and fitter even if it takes a lot of time.

Enjoy the experience. Temper the 
craving to enable 
every single 
notification and 
to interact with 
your fitness app 
multiple times 

a day. It is there to feedback your 
progress, not to become a chore.

Don’t just pick the first tracker 
or smart watch you see. Try a few 
on and see which ones offer the 
features you need and the look you 
are happy with. Bear in mind that 
you may be wearing it for a long  
time to come.

Think long term. Tracking your 
fitness and letting apps guide you 
could become the single most 
important thing you do with your 
iPhone. Potentially, you could be 
happier and healthier, and live 
longer. Good luck!

“Don’t set your goals too 
high or low – aim for a 
steady improvement”
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Create more accurate colours
Perform a white balance operation for better colours 

Photos

 Knowledge base

White Balance
Your camera’s Auto White Balance setting will 
analyse white or grey objects in the scene for colour 
casts. If the white looks cold and blue then the 
camera will warm up the image to create neutral 
whites or greys, banishing any colour casts in the 
process. If whites look too orange the camera cools 
down the shot to create more natural colours. 

 Colour temperature
Different light sources (and even 
sunlight at different times of the day) 
have different colour temperatures. This 
can add colour casts to photos. You 
can manually warm up or cool down a 
photo’s colours using this slider.

 Tint 
As well as colour casts, some photos 
can suffer from a magenta or green tint. 
To counteract a green tint, drag this 
slider right towards the magenta end of 
the scale. To reduce a magenta tint, drag 
this slider left towards green.

 Eyedropper
The White Balance panel’s eyedropper 
enables you to sample an area that 
should be a neutral grey (such as on 
the swan’s shaded wing). It will then 
warm up a cold blue colour cast until 
it’s a neutral gray. This White Balance 
operation creates more accurate colours 
in the rest of the scene. 

 Mixed lighting
The direct sunlit subjects in this scene 
have very warm colours due to the low 
angle afternoon sun. However, subjects 
in the shade can look too cold and blue 
(as was the case in our unprocessed 
start image).

Counteract colour casts
Your camera has to work hard to capture accurate colours 
in different lighting scenarios. Daylight has a cold colour 
temperature which can result in blue colour casts. Artificial 
indoor lighting has a warmer colour temperature that can 
tint the subject orange and create unflattering skin tones. 
Your camera will attempt to perform an Auto White Balance 
operation to produce true colours. However this may not 
always be successful (especially if you’re shooting in mixed 
lighting conditions). If colour casts or tints are still present in 
your picture then you can manually warm up or cool down a 
shot using the Photos app’s powerful White Balance tools.  

Overcome cold or orange colour casts to reveal a subject’s true colours

Download availableaal

Time needed

10

Difficulty

Download available

Before After
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The colour temperature of light is measured in degrees Kelvin. That’s the 
scale you’ll see in the White Balance panel’s temperature slider in Photos.

How to overcome colour castsStep-by-step

1 Import start file 
Go to File>Import and browse to our supplied 
Cast_start01.CR2 image. Click ‘Review for 
Import’ then double-click on the imported 
shot’s thumbnail and click the ‘Edit’ button.

4 Mixed lighting
Click ‘Done’. Import Cast_start02.CR2. 
Boost the Light slider to brighten it. This file 
has a mix of warm sunlight and cold blue 
shadows, so Auto WB will be less effective.

7 Tackle tints 
Incorrect White Balance operations can add 
green or magenta tints (and blue or orange 
casts). To remove hints of green drag the Tint 
slider left towards magenta. Click ‘Done’.

5 Take a sample
Set the White Balance to Temperature/Tint. 
Select the eyedropper. Click the eyedropper 
on a swan’s cold shaded wing. The tool 
warms up the sample to remove cold blues.

8 Orange skin tones
Import Cast_start03.CR2. The skin is too 
orange. We could drag the Temperature 
slider left to cool it down. Or we can prioritise 
the White Balance for skin tones.

6 Golden hour lighting
The shadows on the swan are now free from 
the cold colour cast. To accentuate the warm 
‘golden hour’ lighting, manually drag the 
Temperature slider up to around 8,000. 

9 Use White Balance 
Set the White balance dropdown to ‘Skin 
Tone’. Choose the Eyedropper tool. Click the 
eyedropper on the man’s face to sample his 
skin and cool it down to a more natural hue.

2 Auto White Balance
This shot is too cold and the whites are 
looking blue. As the shaded subject is evenly 
lit you can restore true colours by clicking the 
White Balance panel’s ‘Auto’ button.

3 Colour temperature 
The Auto White Balance operation sets the 
Temperature slider to 5,076 – the colour 
temperature of midday sun. This creates 
more natural colours for this lighting scenario.



Retiming tools
Fine-tune and customise speed changes

iMovie

 Knowledge base

Retime in camera
To create a slow-motion sequence iMovie needs to 
add extra frames of footage to your retimed clip. 
This will cause the slow-motion shot to play back 
quite jerkily. For a much smoother slow-motion 
sequence shoot the footage using your iPhone’s 
Slo-Mo mode. This mode uses a higher frame rate 
that produces smoother slow-motion.

 Need for speed
Click here to access retiming tools that 
enable you to speed up or slow down 
selected timeline footage by a range of 
preset increments. The Speed dropdown 
menu also enables you to freeze the 
action at the playhead.

 Customise speed 
All timeline clips that have been retimed 
using the Speed tools will feature a 
custom speed handle. Drag this handle 
left to speed up the clip or right to slow 
it down by a custom increment.

 Modify 
The Modify menu provides alternative 
ways to freeze or retime your footage. 
You can also summon a cool Instant 
Replay option or reverse time with the 
Rewind command.

 Hare and tortoise
Sections of a clip that have been 
speeded up are indicated by a hare icon.  
Sequences that have been retimed to 
slow down the action feature a tortoise 
icon. Freeze frames feature a hand icon.

 Frame boundary 
In this clip we’ve slowed down the 
footage and then frozen a specific frame 
for a second. By dragging the frame 
boundary icon left you can make the 
action freeze on an earlier frame.

Playing with time
By default our digital devices record video in real time but 
iMovie enables us to take control of time in a variety of creative 
ways thanks to its Speed tools. We can slow down time to 
experience action in a new way (such as seeing someone 
create a splash as they jump into the pool). iMovie enables us 
to highlight key moments with camera-flash style freeze frames, 
adding texture to a wedding video as a bridesmaid catches 
the bouquet, for example. Sports fans can use menu presets 
to quickly replay a goal – complete with TV sport show-style 
action replay captions. We’ll also show you how to experience 
nature in a fresh way by creating a time-lapse sequence.

Create freeze frames, action replays and dramatic slow-motion effects

Download availablethth

Time needed

15

Difficulty

Download available
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To create fast-moving clips without having to retime the footage in iMovie, 
shoot a sequence using your iPhone’s time-lapse mode. 

Retime your footage for creative resultsStep-by-step

1 Import clips 
In the My Media panel, click on ‘iMovie 
Library’. Choose File>New Event from the 
menu. Label the event Time. Click ‘Import 
Media’. Browse to our supplied start clips.

4 Take it slow 
Drag the pedestrians clip into the timeline. 
Click on Speed and set the dropdown to 
Slow. Choose a speed such as 50% to take 
the rush out of rush hour. 

7 Change freeze duration
This two-second freeze frame is indicated by 
a hand icon in the timeline. The duration can 
be adjusted using the custom speed handle. 
Drag it left for a shorter freeze.

5 Custom speed
Both retimed clips in the timeline now have 
a custom speed handle at their top right. 
Drag left to speed up the clip by a custom 
increment. Drag right to slow down the clip.

8 Freeze flash
Drag the FreezeFlash start clip into the 
timeline. Scrub the playhead until the child is 
reaching upwards. Choose Modify>Flash and 
Freeze Frame to add a photographic effect.

6 Freeze a frame 
Drag the playhead until the tourist stops to 
take a snap on her phone. Go to Speed and 
set the dropdown to Freeze Frame. Two 
seconds of the timeline becomes frozen.

9 Instant replay
Add Action Replay start to the timeline. Go to 
Modify>Instant Replay and choose a speed. 
A copy of the clip will replay with a sports-
style caption and at the chosen speed.

2 Speed it up 
Drag the 46-second mountain clip into the 
timeline. Click on the Speed icon. Set the 
Speed dropdown to ‘Fast’. This doubles the 
speed of the clip so it lasts 23 seconds.

3 Go faster 
Next to the Speed dropdown menu you’ll see 
incremental buttons such as 2x, 4x and so 
on. Click the 8x button to create fast flowing 
time-lapse clouds in a shorter 5 second clip.
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Work more efficiently
Organise and edit with these tools and tips

 Knowledge base

Consolidate media
A missing file icon can appear if your Final Cut Pro 
X project is linked to files on an external drive that 
isn’t currently attached to your Mac. If you move 
an imported clip to a different location on your Mac 
then it may vanish from your project. To avoid this 
happening choose File>Consolidate Library Media. 
This will copy all external project files into your Final 
Cut Pro Library.

 Copy and paste
After changing a clip’s audio, colour and even 
composition you can copy the adjustments and paste 
them onto another clip. By using the ‘Paste Attributes’ 
command you can select which attributes will be 
adjusted on the target clip.

 Extend the Inspector 
If you have a lot of adjustments to tweak 
you can double-click at the top of the 
Inspector and it will expand to fill the 
right of the workspace. This saves you 
the hassle of having to scroll up and 
down to adjust various properties. 

 Get Smart 
Smart Collections 
automatically gathers 
clips together according 
to certain properties. 
If you tell Final Cut to 
analyse clips as they are 
imported it will attempt 
to create extra Smart 
Collections based on 
shot size and people.

 Timeline Index 
The Timeline Index helps you 
manage complex timelines 
that are cluttered full of 
assets. You can focus on 
specific colour-coded audio 
roles while collapsing other 
roles into narrower colour 
bars for a less cluttered 
timeline. Here we’re focusing 
on sound effects.

Professional editing tips
Editing can be a time-consuming business, but Final Cut Pro X 
is packed full of ways to speed up your workflow. This month 
we’re going to explore ways to manage complex projects more 
effectively, using tools such as colour-coded roles and Smart 
Collections. We’ll demonstrate how to take the tedium out of 
repetitive tasks such as grading a series of similar shots, and 
we’ll throw in some useful keyboard shortcuts to help you 
manage large projects. This tutorial will also help you avoid the 
common pitfalls that video editors may encounter – such as 
seeing a ‘missing media’ thumbnail in your project instead of a 
clip or photo. 

Speed up your editing workflow with our top tips, tricks and techniques

Download availablemm

Time needed

15

Difficulty

Final Cut Pro X
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Morph fluidly between an interviewee’s jarring jump cuts with the drag and 
drop Flow transition – best with footage from tripod-mounted cameras.  

How to improve your workflowStep-by-step

1 Under one roof
When importing assets, click ‘Copy to library’ 
in the Media Import window. This stops 
media disappearing if the original source file 
changes location or is unavailable.

4 Use custom roles 
Each asset is assigned a colour-coded role. 
Choose Modify>Edit Roles. Create custom 
roles and assign them a colour. This helps 
you locate assets in the timeline more quickly.

7 Make some space
Select tool lets you reposition clips without 
leaving gaps. To move a clip while creating a 
black space press P to activate the Position 
tool. Drag the clip. Press A to return to Select.

5 Timeline Index 
In a cluttered timeline you can focus on 
specific audio roles and collapse other roles 
into colour bars. Go to Index, click Roles and 
click the adjacent circle to focus on a role.

8 Copy and paste
After adjusting properties such as cropping 
and colour, choose Edit>Copy. Choose 
another clip and select Edit>Paste Attributes. 
Tick the attributes you want to transfer.

6 Faster navigation
To zoom out and see the entire timeline press 
Shift+Z. To jump to the next marker press 
Ctrl+’ and to a previous marker Ctrl+;. Press 
fn + the back arrow key to jump to the start.

9 Faster edits
After selecting a clip or range in an Event, 
press W to insert it directly into the timeline at 
the playhead. Or press Q to add the clip on a 
separate layer as a floating cutaway.

2 Import and fix 
In the Import Media window, tick the ‘Analyze 
video for balance colour’ box. This will 
help counteract colour casts and fix audio 
problems as you import your assets.

3 Smart Collections
In Import Media, tick ‘Find People and Create 
Smart Collections after analysis’. This creates 
Smart Collections that can display people 
clips by shot size and by number of people.
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GarageBand

Get to grips with Drum DesignerStep-by-step

How to use Drum Designer
When you start a new GarageBand project finding a rhythmic
groove can take time. Thankfully the growing roster of Drummer
players is a huge help for instantly adding intelligent percussion
patterns that organically follow other tracks or performances.
These virtual players span a myriad of genres and use their
different drum kit types in various ways, all of which can be
customised. In this guide we’ll look at a control element that
lies behind the usual Drummer Editor – the Drum Designer. This
useful Smart Controls panel defines more acutely the volume or
attack levels for each element of a Drummer’s kit, toggling them
on or off and also applying any additional plugin effects.

Discover how percussion levels can be adjusted via a special plugin

Time needed

10

Difficulty

1 Acoustic Drummer 
To start, have at least one yellow Drummer 
track selected within your project featuring a 
real kit-playing player. In this instance we’re 
using Anders from the Rock category.

4 Drum levels 
Each drum element from kick (bass) to 
percussion has a dial that quite simply sets 
the volume of that kit piece within the output 
of the Drummer track’s selected pattern. 

5 Toggled off 
Regardless of which kit pieces are played 
within the Drummer pattern, each element 
is turned on here. Clicking the adjacent lit 
button actually switches that element off.  

6 Electronic instead 
Those Drummers playing electronic kits show 
a vastly different set of synthesizer controls 
instead. The same principle applies however, 
with dials for each virtual element.

2 Smart Controls 
Rather than click the Editors button to open 
the Drummer Editor, view the Smart Controls 
via the adjacent button top left or with the B 
key shortcut, showing the Drum Designer. 

3 Solo and cycle 
From here it’s useful to solo the track via the 
headphone button in the header, cycle the 
Drummer regions in the project timeline and 
press play to preview adjustments.



33

Designer detailed 
Acquaint yourself properly with the wood-clad 
Drum Designer panel found within Smart Controls 

 Drum Kit Designer
Also often labelled as ‘MIX’ this 
set of six dials and toggle buttons 
sets the level of each piece of 
featured kit, enabling elements to 
be switched off entirely or raised 
and lowered in volume.  

 Compression controls
Compression is an extra track 
plugin often applied to Drummer 
by default and is useful for making 
drums tighter and punchier. These 
extra controls turn it on or off while 
also adjusting the amount applied.

 Effects selectors 
These effects controls often 
vary Drummer to Drummer, 
reflecting any extra plug-ins 
applied in the inspector. Usually 
they adjust general drum tone, 
brightening or deadening, along 
with adding ‘Room’ reverb for 
more natural ambience.  

 Drum Designer plugin 
The Drum Designer is actually a 
plugin found within the inspector  
of the Smart Controls panel for  
any actual kit-playing Drummer. 
Extra plug-ins listed in the box 
below will add controls such as 
compression or effects.

To view acoustic Drum Designer controls, you need a natural kit-playing 
Drummer track selected before clicking Smart Controls or pressing ‘B’.

 Knowledge base

Some natural balance
The real value of the Smart Controls for natural 
kit or electronic Drummer tracks is in balancing 
the performance. Adjusting the volume or attack 
of a kit part, whether it is drum, hi-hat, cymbal 
or percussion, is useful for emphasising those 
hits, strikes or fills within a pattern. This is worth 
remembering as an advanced customisation 
technique for achieving a more natural result.

Most commonly, the kit parts or the drums being
played are defined within the Drummer Editor (E)
panel. Here you’ll find a visualisation that doubles
as drum kit controls for toggling on or off elements
of the kit itself, before the sliders and knobs dictate
the number of fills.

Obviously this will determine what the Drum
Designer within Smart Controls can do, so in the
following steps we’ll take a look between the
two panels at how one dictates to the other and
observe the impact.

1 Helping hands 
First we’ll show the Drummer Editor on our 
selected Drummer track in our project. Here we 
will click on the ‘hand’ percussion icon to add 
handclaps to the pattern. To add enough audible 
fills, we have the slider set to two.   

2 Percussion power 
If we switch back to Smart Controls and the 
Drum Designer knobs, we can adjust the applied 
handclap percussion selection. Raising the level 
right up will elevate and emphasise its volume in 
the pattern, whereas dialling it back quietens it.      

Picking  
kit parts 



Access all areas
Speed up your mixing process with 
Automation Quick Access (AQA)

Logic Pro X

 Knowledge base

Faders vs knobs
Faders usually work best for AQA, as they transmit 
MIDI messages with a defined range of values, 
perfect for writing automation data. The type 
of endless encoder knob found on many MIDI 
keyboard controllers is less up to the task, but the 
modulation wheel will also work quite well if there 
are no other controllers available on your connected 
MIDI keyboard.

 Learn Message
Click the ‘Learn Message’ button to 
assign a new, different controller to use 
with Automation Quick Access.

 Edit Assignment
Click ‘Edit’ to access Logic’s Controller 
Assignments window, in which you can 
assign a new controller manually.

 Toolbar trick
You can set an AQA on/off button to 
appear in the toolbar by choosing 
‘Customize Toolbar’ from the View menu 
and checking the AQA checkbox.

 Touch mode/Read mode
Use Touch mode to make changes to 
the automation data, and Read mode to 
play the changes back.

Automation Quick Access
Logic’s track automation system is very powerful, allowing 
you to record and play back dynamic changes to almost any 
soft synth or audio effect parameter within the app, whether 
it’s opening a synth’s filter during a build, say, or increasing 
the amount of effect on the vocal. Versatile and easy to use 
as it may be, Apple’s engineers have come up with a simple, 
yet little-known trick called Automation Quick Access (AQA) 
to further simplify the process. With AQA enabled, you can 
designate any single hardware control on your MIDI controller 
– a knob, fader or even the modulation wheel – to write 
automation for whatever parameter you have selected.

Logic Pro X contains a handy hidden feature for intricate programming

Download availabletoto

Time needed

10

Difficulty

Download available

34
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Use the ‘Toggle AQA’ key command (Ctrl+Option+Cmd+A) to switch 
between using the mod wheel for AQA and regular mod wheel duties.

Using Automation Quick AccessStep-by-step

1 Express a preference
Begin by selecting Preferences>Automation 
from the Logic Pro X menu. You should find 
that the Automation Quick Access option 
(AQA) is disabled by default.

4 Done deal
Click the ‘Done’ button and it changes to 
‘Learn Message’. The selected controller is 
now your designated AQA controller, and the 
AQA switch should now be on.

7 Write away
In the track header, switch the channel’s 
automation mode to ‘Touch’ and hit Play. 
Using your controller, write in a pass of filter 
cutoff automation similar to that shown here.

5 A for automation
Let’s put AQA to work with a basic sequence 
played by Logic’s RetroSynth instrument. 
Click the ‘A’ key on your keyboard to enable 
track automation.

8 Resonance 
Now let’s select a different parameter to 
automate – let’s go for Filter Resonance this 
time. Arm the track for writing by switching 
from ‘Read’ to ‘Touch’ mode once more.

6 Select parameter
From the parameter submenu, select 
Filter>Cutoff. This will bring up the 
appropriate automation curve for this 
parameter in the track’s automation lane.

9 Write again
Now you can use the same controller as 
before to write in the automation data for 
your filter resonance. It will control whatever 
the current parameter is on the active track.

2 Click AQA button
Click the ‘On’ button to enable AQA. A 
dialogue window opens asking you to assign 
a controller. Faders tend to work better than 
endless encoders for this.

3 Assign of the times
Click the ‘Assign’ button and carefully  
move the designated hardware controller  
on your MIDI keyboard through its full  
range of motion.
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macOS

How to speed up your MacStep-by-step

Speed up your Mac
Over time the efficiency of our Macs tends to dip and they
become sluggish. There are numerous reasons for this;
perhaps you have recently updated your Mac operating system
and the efficiency of some of your apps is suffering as a result;
or maybe you have too many apps open that you just don’t
need? It may just be that your hard drive is congested with
junk files that you don’t know you can simply delete. Whatever
the reason for the downturn in overall performance, there are
quick and easy fixes that you can carry out that won’t cost you
a bean. Here we guide you through some and recommend a
good, free app for decluttering your Mac’s hard drive.

Does your Mac feel sluggish? Here are some tips for turbo-charging it!

Download availablethth

Time needed

10

Difficulty

1 Update your apps
Outdated apps in newer operating systems 
can prove to be glitchy and sluggish, so 
launch the App Store, click on ‘Updates’ and 
update every app that you can.

4 Turn off startup items
Your Mac may be sluggish due to an array of 
open apps that booted up at startup. Go to 
System Preferences>Users & Groups, click 
on your name and click on ‘Login Items’. 

5 Disable apps
If you see apps that you don’t need open, 
click on the padlock icon and enter your 
administrator’s password, click on the app 
name and then click on ‘–’ underneath.

6 Disable visual effects
The macOS has visual effects that slow down 
older Macs when running the latest operating 
systems. Go to System Preferences>Dock 
and uncheck boxes such as ‘Magnification’.

2 Check Activity Monitor
Launch Activity Monitor, select View> 
Windowed Processes and click on ‘CPU’ to 
check the biggest drainers on your Mac and 
consider quitting anything you don’t need.

3 Check Energy
If you are using a laptop, while in Activity 
Monitor, click on ‘Energy’ to see which apps 
drain the most energy from your battery. If 
power is getting short, close unused apps.
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Optimise your Mac
Quick ways to improve performance

 Simple Dock
Processing power is used every time you call up your 
Dock if it isn’t an ever-present on your screen. You should 
also disable things like ‘Animate opening applications’ 
and ‘Minimize windows into application icon’.

Use Activity Monitor
Activity Monitor is a very useful 
app for helping you monitor various 
aspects of app usage. For example, 
you can see which apps use the most 
memory, present the biggest drain of 
your MacBook battery, etc.

 Disable the flashiness
Visual effects are common in Mac 
operating systems – snazzy ways 
to present basic actions, such as 
minimising windows. Go to System 
Preferences>Dock and you will be 
able to turn off many of these effects.

 Check for updates
Apps performing sluggishly may be 
an indication that they are simply 
out of date with your new operating 
system. Go to the App Store and 
click on the ‘Updates’ tab to see if 
any newer, more stable versions of 
the app are available.

Keep your apps up-to-date by going to App Store>Preferences and ticking 
‘Automatically check for updates’ and the sub-categories relating to it. 

 Knowledge base

Minimising windows
When trying to reduce the number of visual effects 
that your Mac uses in order to eradicate slowdown, 
go to System Preferences>Dock, as per ‘Step 6’ 
and then change the ‘Minimize windows using:’ 
option from ‘Genie Effect’ to ‘Scale Effect’ for a 
much more straightforward, less CPU-intensive 
transition effect. Every little helps!

There are also plenty of apps available to help
defrag and declutter your Mac and speed up
the performance and one of our favourites is Dr
Cleaner: Disk, Mem Clean. A free version of this
app is available from the App Store and, when
launched, it will operate as a neat little menu bar
item that you can click on to get a performance
overview of your Mac. This app is also very good
at identifying useless files on your Mac and
deleting them to free up space.

1 Start optimising
With Dr Cleaner installed, click on the menu bar 
item and then click on ‘System Optimizer’. In the 
window that appears, ensure you are in the ‘Junk 
Files’ section and then click on ‘Scan’. The app 
will now search for superfluous files.

2 Delete clutter
Once the scan has been carried out you will be 
able to see all the junk files on your Mac and how 
much space they take up. Review the list and then 
consider dumping the lot of them to free up space 
and improve your Mac’s overall performance.

Get an app

“Plenty of apps help defrag 
and declutter your Mac”
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macOS 

Connect your Mac anywhereStep-by-step

Use your Mac with a Wi-Fi hotspot
There are many advantages to using your own mobile 
connection with your Mac. Firstly, you will be able to connect 
anywhere there is a mobile signal. 4G is fast enough to power 
through the most demanding of tasks and you are less likely to 
suffer from contention where others are using the same Wi-Fi 
connection. Also, you can be assured of better security than 
when using a public connection. Using random Wi-Fi hotspots 
is never a good idea and particularly so because in all other 
areas macOS is very secure so it makes no sense to put that 
at risk. We will now demonstrate how easy it is to run a speedy 
connection on your Mac no matter where you are.

Using a Wi-Fi hotspot is the next best thing to a MacBook with a SIM card slot

Download availableisis

Time needed

10

Difficulty

1 Connect to Wi-Fi 
Connect to Wi-Fi as you normally would and 
you should see your iPhone, or other phone, 
listed within the possible connections. Simply 
click on it to start the process.

4 iPhones see everything 
The iPhone should prompt you to share the 
connection the first time and this will negate 
the need to enter a password at all on your 
Mac. The setup will then be complete.

5 An active connection 
While the hotspot is active and being used 
by your Mac you will see a blue marker at 
the top of the iPhone screen. You will always 
know when it is active and using data.  

6 Use as normal 
You will be able to use the Mac through the 
iPhone as normal – it should feel no different 
to using a standard Wi-Fi connection, even 
when viewing complex websites. 

2 Enable the hotspot 
On your iPhone, go to Settings>Personal 
Hotspot and then tap the ‘Personal Hotspot’ 
icon at the top to make the hotspot active. 
This is required to start the connection.

3 Input security code 
When you click on the ‘iPhone’ listed in the 
Wi-Fi list, you will see a new panel appear 
with a security code that needs to be input. 
This is a one-time only process. 
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A simple setup
A couple of clicks to connect

Wired connections
If you run into problems, you can
connect your iPhone to your Mac
using USB for troubleshooting
purposes or for the fastest possible
mobile connection. It will be even
more secure.

True mobile Wi-Fi
When you click on the Wi-Fi icon
at the top you will see your iPhone
listed provided it is Wi-Fi and/or
Bluetooth-enabled. It is there to
connect to in an instant.

Stay secure
A password will be set within the
hotspot to ensure that your connection
remains secure and that no one else
can connect to it if their computer
detects it. Make it truly secure.

Bluetooth connections
Your Mac can connect to your
iPhone via Bluetooth as well
meaning that you have multiple
options to ensure a safe and
reliable connection at all times. It
should work every single time.

You can use your phone as normal while your Mac is tethered to it, but you 
may see a natural reduction in network speed.

Knowledge base

Cover the bases
You will need to ensure that tethering is available
on your mobile contract and that you have enough
allowance to do so without having to constantly
worry about going over your limit. Some mobile
providers will seriously limit tethering so you may
need to shop around to find a deal that works best
for you and your Mac.

You may come across problems when you
initially try to connect with your iPhone, but don’t
worry about this too much because there are
some very simple steps you can take to get the
connection going and they will almost always
work. Apple has worked hard to ensure that
the wireless side is reliable now and you really
should not see many problems at all, even with
the first connection.

Here we highlight some easy steps you can
take to fix any potential problems…

1 The failed connection 
An alert will display if your Mac cannot connect  
to the iPhone or if the hotspot is not active on  
the iPhone. Try turning the iPhone off and on  
fully and if that does not help, you can reset 
network settings. 

2 Test the connection 
You should also try connection to your iPhone  
via Bluetooth or using a USB cable just to make 
sure that the two devices can see each other. If 
these work, the Wi-Fi hotspot connection should 
work as well. 

Troubleshooting 
connections 

“A password will be set within 
the hotspot to ensure that your 

connection remains secure”
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Safari

Upload and transcribe audio filesStep-by-step

Automatically transcribe audio
If you’ve ever needed to transcribe audio, then you’ll know 
what a hassle it can be. It can consume hours of your time as 
you try and decipher what someone is saying. So when we saw 
a service that claims to speed up the process using artificial 
intelligence, we jumped at the chance to try it. Trint allows you 
to upload MP3, MP4, M4A, AAC and WAV audio along with 
MP4, WMA, MOV and AVI video and it speedily transcribes 
them all. In truth, the result isn’t anywhere near 100 per cent 
accurate so you’ll still have a fair bit of editing to do but the 
good news is the editing facilities are very good. There’s also a 
30-minute trial so you can try it out for yourself without penalty.

Transcribing audio is a pain but Trint gives you a head start by using artificial intelligence

Download availablethth

Time needed

30

Difficulty

1 Sign up
Visit https://trint.com/ and click ‘Start Free 
Trial Now’. Simply input your details and a 
password before confirming the email and 
filling in a basic three-question survey. 

4 Select a file
Click the location of your file in the left-hand 
menu (you can grab files from your computer, 
cloud storage services, links and FTP). Now 
find your file and click ‘Choose’.

5 Begin transcribing
It’s also possible to drag files to the screen 
and you can add more than one too (bear in 
mind the free trial allows a maximum of 30 
minutes). When you’re done, click ‘Upload’.

6 Select a language
Choose a language and click ‘Continue’. The 
file will now upload and begin transcribing. 
Once it’s complete, a Ready prompt appears. 
Click the filename to see the transcript.

2 Upload a file
Trint runs within the browser so you’ll find 
yourself looking at the main Trint screen. To 
start uploading an audio file, click the Upload 
button in the top-right corner.

3 Complete check list
Trint will work better if the background is 
noise-free, the voices are close to the mic, 
there is no overtalk and the accents are clear. 
But you can also click ‘Proceed Anyway’.
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Edit your transcription
Trint makes a fair few errors during the transcription process 
so you will need to go through and rectify these

 Highlight text
It is possible to highlight sections 
of the text. Doing so shows you the 
timestamps for the selection. You can 
also choose to play only the highlights.

 Play back audio
Click anywhere on your transcription 
and select the Play button to listen 
to your recorded audio from that 
spot. You can also press the rewind 
button to go back five seconds: 
click it twice to go back ten.

 Control the speed
At the bottom of the screen is an 
option to speed up or slow down the 
playback. Double-speed allows for 
the quick checking of a transcript. 
Half-speed makes editing easier.

 Insert speaker names
If more than one person is talking, 
it’s a good idea to identify them. 
Click any one of these arrows to 
add the name of the speaker of 
each chunk of text.

Worried that someone might be able to access your audio and 
transcriptions? Trint promises that your files will be kept fully secure.

 Knowledge base

Saving your audio transcriptions
When you have finished with your transcription, 
you can export it. Click the ‘Export’ button in the 
top-right of the screen and you can choose from 
a variety of formats including Microsoft Word, 
JavaScript/HTML, subtitles and captions and EDL 
for use in video editing suites. You can also choose 
to export the highlights only as a Word doc.

Arguably the most useful function of Trint is its
editing function since it cleverly allows you to jump
to any point in the text, listen to what is being said
and make any necessary amendments. Even if the
automatic transcription is a tad gobbledegook, we
found this was still faster than transcribing from
scratch. To make life even easier, though, Trint
also has a list of editor preferences which you can
toggle on and off.

1 Click on Preferences
Open a transcription within Trint and click the 
Preferences button at the bottom of the screen. 
You will then see a window containing eight key 
preferences. Each one has a toggle button next to 
it which allows you to turn the functions on or off.

2 Make a choice
Go through each option, deciding if the function 
suits your needs. Click ‘Close’ and the preference 
changes will take immediate effect. You can also 
click ‘More Shortcuts’ at the bottom of the screen 
to view time-saving key presses.

How to alter 
the editing 
preferences
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Mail

Try Mail’s new featuresStep-by-step

New features in Mail
When macOS High Sierra was released, Apple made a few 
tweaks to the Mail app. It was a great email client already, so 
there aren’t any major changes. However, there are several 
improvements to existing features that make dealing with email 
messages easier. The use of trackpad gestures is handy for 
example and we show you how to use this and configure it. 
There have been some useful changes to the search facility, 
which now makes it easier to find messages you are looking for 
– a bit of AI (artificial intelligence) puts the most likely results first 
for example. The content of email messages can also be more 
brightly coloured now that the background of text can be set.

Discover and master the great new features in the Mail app for macOS High Sierra

Download availbleww

Time needed

10

Difficulty

1 Top hits 
Finding emails is now easier. Enter a search 
term and in the results is a ‘Top Hits’ section. 
By analysing your emails, Mail shows what it 
thinks you are looking for first.

4 Enable split view
Another tweak to Mail is split view, which 
divides full-screen view to show Mail and 
messages. Go to Mail>Preferences and tick 
the split view option on the General tab.

5 Customise spaces
This step may be necessary on some Macs 
– it was on ours. Open Mission Control in 
System Preferences and tick ‘Displays have 
separate Spaces’. Weird, but essential.

6 Use split view
Click the green window button to go full-
screen. Double-click an email to open it or 
create a new message and it opens on the 
right. Click and drag the vertical divider.

2 See unread emails
Click the tiny icon in the header above the 
main results and the messages are filtered to 
show just the unread ones. There is also an 
option to sort the results by date.

3 Filter search results
Click the ‘Unread’ link and a number of filters 
are displayed. For example, results can be 
filtered by email account, unread, flagged, 
only from VIPs and only with attachments.
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Mail’s new features
Colour your emails and search better

 Swipe away
You can clean your inbox by swiping 
left over an email and it can either 
be deleted or archived in one 
gesture. Choose which action you 
want to perform in Mail Preferences.

 Colour your messages
There is a new option to set the 
background colour of text when 
writing emails. Select some text, 
then click this colour chip in the 
toolbar to show the palette and click 
a colour.

 Remove text colour
There does not appear to be an 
option to remove colour from 
text, but there is actually a special 
colour in the palette. Click this one 
with the line through to remove the 
background colour.

 Top Hits
When a search is performed, a 
small number of items appear in 
a Top Hits section here. They are 
what Mail thinks are the messages 
you are most likely looking for 
based on your previous interaction.

Let the mouse hover over the dividing line between an email header and the 
email body to show a secret toolbar.

 Knowledge base

Archive your emails
Clearing your email inbox is a liberating experience 
and it can be done with gestures. As shown in 
the tutorial and annotated image, swiping over a 
message will delete it or archive it depending on the 
Preferences setting. Where do archived emails go? 
The archive is simply a folder in the Mail sidebar. 
Use it to store messages you don’t need to keep in 
your inbox, but which you don’t want to delete.

The Mail app responds to trackpad gestures
and you’ll find that these can make dealing with
your emails much faster. A two-finger swipe up
or down the trackpad is a standard gesture for
scrolling up and down. However, you may not
have realised that you can also swipe left and
right with two fingers. This gesture, borrowed
from the iPhone, performs actions that can be
customised by going to Mail>Preferences>
Viewing>Discard messages into. The options are
either Trash or Archive.

1 Move messages 
Use one finger on the trackpad to move the 
mouse pointer and position it over an email 
preview. Then hold two fingers down and swipe 
left to reveal a Trash icon. (You can switch this to 
Archive in Preferences.)

2 Read/unread messages
Position the mouse over an email and then  
swipe right to reveal a blue icon. Tap on this to 
toggle between read and unread status. Swipe 
halfway and tap or swipe all the way to apply the 
action immediately.

Use trackpad 
gestures
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Calendar

How to set up your calendarStep-by-step

Create a shared family calendar
Now that a new year is upon us, we’ll all want to start making 
plans for the months ahead – such as birthday parties and 
gatherings to bring scattered family members together. It can 
be tiresome planning such events and making sure everyone 
gets notified… but not with Apple’s iCloud Family Sharing 
feature. Once you set this up and add family members, you 
will automatically create a family calendar that all connected 
family members have access to on their Macs and iOS devices, 
and when you create new events they will be instantly notified. 
What’s more, they can edit events, add in additional details and 
even delete them – the flexibility is flawless. 

Keep your family organised with a shared calendar through iCloud Family Sharing

Download availablefafa

Time needed

10

Difficulty

1 Set up Family Sharing
Go to System Preferences>iCloud, click on 
‘Set up Family Sharing’ and go through the 
initial setup. Once set up, a ‘Family’ calendar 
will be shared with all connected members.

4 Choose calendar
Double-check that you have selected the 
Family calendar for the event by clicking on 
the dropdown arrow in the top-right corner of 
the event box and ensuring it says ‘Family’. 

5 Mail out event
If you wish to share your event with people 
not attached to your Family Sharing right-
click on the event and choose ‘Mail Event’. 
The event will be applied to a new Mail draft.

6 Get notified
Once the event has been created in the 
Family Calendar, everyone who is connected 
to that calendar will receive a notification on 
their Mac or iOS device. 

2 Open Calendar
Open Calendar app and click on ‘Calendars’ 
in the top-left corner to display all your 
calendars. The ‘Family’ calendar should be in 
this list. Make sure it is enabled.

3 Create an event
Click on ‘+’ to create a Quick Event on the 
current day, or right-click on a different day 
and choose ‘New Event’. Give the event a 
title and then set the ‘start’ and ‘end’ times. 
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Sharing calendar events
Using iCloud to connect the family

 Creating events
After adding all of the required 
information into a new Family 
calendar event (such as times, 
location, etc) it will instantly be 
shared to all connected family 
members and they will receive 
notifications on their devices. 

 Other iCloud perks
Through Family Sharing you can also share 
purchases from the App Stores and you can 
also get an Apple Music family membership that 
provides access to over 40 million tracks for up to 
six family members.

 Sharing storage
You can also share iCloud space through Family 
Sharing. It seems that everyone soon eats through 
their free 5GB allocation, yet 200GB is far too 
much for most of us – so it makes sense to share 
all of that space amongst the family.

 Your Family calendar
When you set up Family Sharing,
all family members that you add 
will be automatically connected to
a shared ‘Family’ calendar. When
new events are created they are 
then relayed to all family members.

Go to Calendar>Preferences>Alerts and ensure ‘Show invitation messages 
in Notification Centre’ is ticked to be sure you don’t miss family event alerts.

 Knowledge base

Family default
You can make your shared Family calendar your 
default calendar by going to Calendar>Preferences 
and then clicking on the ‘General’ tab. Here you 
will see an option called ‘Default Calendar’ – click 
on this and then choose ‘Family’ from the list. Hey 
presto, you need never miss an important family 
gathering again!

Another useful aspect of the Family calendar
is that you can monitor the activity of family
members through the calendar and all connected
family members can edit events created in the
Family calendar. For example, if an event has
been created and shared (as it automatically is)
then other family members are able to change
details of the event and even delete it if it is no
longer applicable. Family members will also
receive notifications of the changes, as we will
demonstrate here…

1 Deleting 
events
If a family member 
receives notification 
of a new event and 
then checks the 
details of the event 
on their device, 
they will have the 
option to edit the 
details or delete 
it if it is no longer 
applicable. Tap on 
the ‘Edit’ or ‘Delete 
Event’ options 
respectively.

2 Monitor activity
Any changes will be relayed to other connected 
family members. If using a Mac you will be able to 
click on the invitations icon in the top-left corner 
of the Calendar app interface and, if someone has 
deleted an event, you’ll be notified here.

Monitoring 
family activity
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macOS

Using macOS High Sierra’s management toolsStep-by-step

Manage your Mac storage
Storage remains as fundamental as ever in computing and in 
an era of photos, videos, music and apps we all crave more. 
Despite pocketing devices boasting the sort of GB capacity 
that would have made Deep Blue blush, this fervent file 
retention now sprawls online – a move with useful implications 
for desktops too. With macOS High Sierra, Apple has 
recognised this increasing storage flexibility by including custom 
management tools for decluttering your system drive. Useful for 
improving performance, not least clearing room for more stuff, 
the features embrace iCloud and iTunes and can be tweaked to 
the max. So in this guide we take a closer look…

Master the storage management tools within Apple’s latest OS

Download availablemm

Time needed

10

Difficulty

1 About This Mac
From the macOS desktop navigate to and 
select Apple>About This Mac from the main 
Finder menu bar. You should see the ‘About’ 
dialog showing the Overview tab.

4 Optimize options
Click ‘Optimize’ and checkboxes toggle 
automatic removal of watched iTunes videos 
and a choice between downloading new 
email attachments or none at all.

5 Trash talking
The third button is useful if you often have a 
brimming Trash basket. Turning this feature 
on will automatically erase those files that 
have been trashed for over 30 days.

6 Reduce clutter
Click ‘Review Files’ to show the Documents 
item. Large Files and Downloads are shown 
ordered by size for selection and deletion, 
while File Browser offers folder navigation.

2 Storage tab
Click ‘Storage’ to view connected devices. A 
colour-coded bar shows how the hard drive 
is populated, but click ‘Manage’ to the right 
to show the Recommendations box.

3 iCloud Storage
Click the first button to transfer your photos 
and videos to the iCloud Photo Library and 
save space by keeping optimised versions on 
the Mac. You can re-download them later.
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Hover your mouse over the drive percentage bar in Storage to view pop-up 
tool tips indicating how much disk space each section of files occupies. 

7 Deleting files 
If a little cross icon shows as you hover over 
a listed file, you can click this to choose the 
file for permanent deletion or the magnifying 
glass to view within Finder.

8 Applications view 
Under Applications, you can again view 
installed apps by size and delete as desired. 
Clicking the ‘Open Applications’ button 
opens the folder within a Finder window.

9 iOS Files
Aside from the other items, iOS Files is useful 
for identifying old device backups and iOS 
installers. They can simply be deleted in the 
same way, using the cross icon.

Unboxing macOS storage
We pick apart the key components and tools within High Sierra’s management utility

 Knowledge base

Downloadable content
The manage storage utility 
allows a number of files to be 
deleted that you can always 
download again. One such 
selection is Music Creation, 
where GarageBand’s Sound 
Library can be removed 
completely and easily 
re-installed through the app. 
Just like Mail attachments and 
iTunes content, these files can 
grow very large and are useful 
to lose when clearing significant 
space quickly.

 Optimize Storage
Click this button to take actions 
such as removing any locally 
downloaded iTunes videos once 
watched, such as TV episodes 
and feature films. Things like 
only your most recent email 
attachments will be retained.

 Trash & Clutter
Turn on this to toggle the 
automatic erasure of trashed items 
after a 30-day period. The Review 
Files button then shows redundant 
files or content that can be 
manually deleted to remove clutter.

 Store in iCloud
This option automates the shifting 
of all file and photo storage onto 
iCloud instead of local system 
drives. Only recently accessed 
documents and those optimised 
photos, etc are kept on your Mac 
to maximise space.

 Recommendations  
and file types
The first item shows the 
Recommendations pane by 
default, containing the main four 
button-based controls. Below 
this are listed the various stored 
file types, iCloud and programs 
you can view to make more 
direct changes.



Every situation covered
Siri is in tune with you and your Mac

Siri

 Beyond the conventions
Siri now goes beyond the original 
conventions that we expect of the 
service and you really can ask almost 
anything you like. The answers you need 
will almost certainly come your way.

Seeing it all
Simple questions concerning the
amount of free storage you have and
the processor speed of your Mac can be
answered by Siri in an instant. It knows
your entire system inside and out.

 In the system
Siri is able to work with your Mac and let 
you do many things such as open apps 
and change settings that would otherwise 
require entering various screens to 
accomplish. It’s a big time saver.

“You can add reminders, create 
calendar entries and message 
others using just your voice”
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10 lesser known Siri tricks
Siri on the Mac can be a hugely advantageous feature if you use 
your Mac a lot. It enables you to quickly check for answers to 
questions and to effectively have access to all of the information 
the internet has to offer. You can add reminders, create calendar 
entries and message others using just your voice, but there are 
many other features within Siri that you may not be aware of. It is 
only when you look below the surface that you realise just what 
Siri can do and we hope to give you some pointers on where to 
start. You can take these examples as just the tip of the iceberg 
because the deeper you look into Siri’s features, the more useful 
things you will find. For more serious tasks, Siri works even better 
on the Mac than it does on the iPhone.

Siri can be just as useful on a Mac as an iPhone

1  Search for tweets 
Provided you have a Twitter 

account linked in macOS you will 
be able to ask Siri to search for 
tweets by a user name or look 
for those related to a particular 
subject. It is much more efficient 
than using Twitter directly. An 
excellent feature.

2 Manage your Mac
Diving into Settings and 

clicking a few options is not a huge 
hardship, but it may seem so after 
you have used Siri to perform the 
same actions. You can ask Siri to 
interact with many parts of your 
Mac and the results are quite 
surprising when you first try to  
use them.



With the imminent release of HomePod, you can expect Siri to grow in 
stature and usefulness in the near future. It’s improving all the time.

5 File and folders
As your time with any Mac grows 

so will the number of files and folders 
stored on it. This can make finding 
specific items tricky, but again Siri can 
help. Ask Siri to find any file or folder 
by name and clickable results will be 
presented. Siri really can do so much.

6 Save media results
If you ask Siri to display images

of an object or an animal, you will be
given a set of results derived from a
standard internet search. You can then
click on any image and drag it to the
Notes app or many other apps and
use it for your own purposes. Very
clever integration.

7 Ask almost anything
Try to avoid any preconceptions 

as to what Siri is able to offer and try
asking for anything you like. Of course
Siri cannot cover every possible
use, but you may be surprised at the
variety of uses it can offer. You can
ask for the time in another country,
for example.

8 Use the time
Siri uses natural language in 

ways that you may find hard to believe
at times. Ask Siri to find a document 
you were working on yesterday by 
simply including the related app in  
the question. A list of file matches  
will appear which can be clicked to 
open immediately.

9 Control your apps
To make changes to the way 

apps behave, you can ask Siri to open 
the settings for the app in question 
which is much easier than searching 
for the screens you need to access. 
You can also open apps using Siri and 
almost use your Mac hands-free for 
many everyday tasks.

10  Get instant help
If you run into problems with 

your Mac or any Apple product you 
can ask Siri for help. For example, 
stating that you have forgotten your 
Apple ID password will be answered 
with the link you need to go to for 
help. It’s like having your own personal 
support representative.

4  Access system 
information

Siri is also embedded in a Mac in a 
way which means that it has access 
to the system data you need. You 
can ask how much storage you have 
left on your Mac and even how much 
iCloud space you have available. The 
results are presented in an instant.

3  What’s 
that song?

Siri can offer the same 
benefits as Shazam 
on a Mac without the 
need to even have 
the app installed. If a 
song is playing in the 
background you can 
ask Siri, “What is this 
song?” and your Mac 
microphone will listen 
and then magically 
present all of the details 
you need.
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iTunes

How to make your own ringtonesStep-by-step

Create a new ringtone
As you are probably aware, there is a whole wing of the iTunes
Store dedicated to ringtones for your iPhone. However, if the
tone you want isn’t available or you simply want to save money
and create your own version then you can do this relatively easily
in your Mac’s iTunes app. All you have to do is right-click on the
song you want to use, choose the ‘Get Song Info’ option and
then set the start and end points of the track to essentially ‘trim’
it down to a tone-friendly size that can be looped as your phone
rings. We will guide you through the process in more detail now,
but it is a handy way to create quick and easy ringtones that you
can even gift to friends and family.

Fashion your own ringtone out of an iTunes track

Download availableitit

Time needed

10

Difficulty

1 Select a song
Go to your iTunes library and select the song 
that you would like to use for your ringtone. 
Once done, right-click on the song and then 
choose ‘Song Info’ from the menu.

4 Loop song
Once you have defined your timestamps, 
click ‘OK’ and then loop the track (click the 
icon to the right of the playback window 
twice) to see if it works as a ringtone.

5 Convert the track
When you are happy with how well the track 
meshes together when looped, highlight it 
and then go to File>Convert>Create AAC 
Version. iTunes will now duplicate the track. 

6 Delete parameters
Go back to the original track, right-click and 
choose ‘Get Song Info’ and click ‘Options’. 
You can now remove the timestamps to 
revert the track back to normal length.

2 Select start/end times
In the Song Info window, click on ‘Options’ 
and you will see ‘Start’ and ‘Stop’ options 
– these help you define the section that you 
would like to use for your ringtone.

3 Enter times
If you want to use the beginning of the track 
as your ringtone then you only have to tick 
the ‘Stop’ box and enter the time to stop in 
the field next to it.
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Ringtone knowhow
Make a tone out of any track

 Choosing a song
You can turn any song from your 
iTunes library into a funky ringtone. 
When you find a track to use simply 
right-click on it and then choose 
‘Get Song Info’ to get started.

 Loop the new track
In order to find out if your chosen 
song section works as a ringtone, 
click on this button twice (so that 
the ‘1’ is displayed in the top-right 
corner) and then play the track to 
loop it.

 Start and end
By selecting the ‘Start’ and ‘Stop’ 
points of your song you will 
essentially be ‘trimming’ it down to 
a ringtone-friendly length that can 
be looped. You can select these 
points under the ‘Options’ tab.

 Copy to your iPhone
When you are happy with how your 
ringtone sounds, you will need to 
change the file extension and then 
copy it to your iPhone. Simply 
connect it and click on this icon to 
get started.

Remember you can also change the way the track sounds by right-clicking 
on it and choosing Get Song Info>Options and then selecting an equaliser.

 Knowledge base

Deleting the edited track
When you have finished copying your ringtone 
you should delete the shortened track from your 
iTunes library. To do this, right-click on the track 
and choose ‘Delete From Library’. However, if you 
haven’t yet copied the song then it is important to 
only delete the track from your iTunes library, not 
your Mac hard drive – so when you see a message 
asking if you want to move the file to the trash, click 
‘Keep File’.

Now that you have created the ringtone, you
will need to get it onto your iPhone. First of all,
right-click on your newly trimmed track and
choose ‘Show in Finder’. You should now be
able to see the track in a Finder window (it will
be in the same album folder as the other tracks
from the same album, probably with a ‘1’ after its
name). Click on the name of the new track and
then edit the last three letters of the file from
.m4a to .m4r. Confirm the prompt and connect
your iPhone.

1 Go to ‘Tones’
Once your iPhone is connected, click on the 
iPhone logo in the iTunes app (next to the content 
menu in the top-left corner of the interface) and 
then, in the sidebar, under ‘On My Device’, click 
on ‘Tones’.

2 Drag and drop
You can now simply drag and drop the ringtone 
that you have created from the Finder window 
to the Tones screen in iTunes. Once it has 
copied, eject your iPhone and then go to 
Settings>Sounds>Ringtone and select it.

Sync the 
ringtone



Quick
close

To get back to the previous
screen when listening to a
track, you can tap the arrow
in the top-left of the iPhone
screen, but it’s quicker to
just swipe down on the

album cover.

EVERYTHING YOU CAN DO WITH 

MUSIC
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When you are asked to choose artists at the start of the Apple Music experience, you’ll 
automatically subscribe to them in Connect.

“There’s always something 
to listen to if you don’t fancy 

diving in and browsing the 
catalogue manually”

The complete guide to Apple’s audio streaming service
pple has always been passionate 
about music. In the years since 
the launch of iTunes and the iPod, 
Steve Jobs and, more recently, 

executives like Eddy Cue, have played 
everything from Coldplay to Foo Fighters 
during demos of new products. Jobs was 
famously a huge fan of Bob Dylan, and 
arguably, Apple has done more than any 
other company to help the music business 
progress, adapt and stay relevant in  
the 21st century – and Apple Music has  

been instrumental  
in this.

First launched in 2015, this music 
streaming service gives any iPhone, iPad, 
Mac, PC or Android user access to a 
massive selection of songs to stream and 
download. The service offers a free three-
month trial for everyone, during which you 
can listen to almost any track in the iTunes 
library, and download for offline listening. 
You’ll have access to millions of songs, and 
the service will provide you with personal 
recommendations from people who know 
and love music – so your playlists won’t 
just be a random collection of songs, but 
a curated list of tracks that sound great 
together and tell a story. There’s also a 
worldwide radio station called Beats 1 – 
bringing the latest tracks and interviews 

with top artists, and playing 24 hours  
a day. With studios in Los Angeles,  
New York and London providing around-
the-clock listening, you’ll find that there’s 
always something to listen to if you  
don’t fancy diving in and browsing the 
catalogue manually.

Since launch, Apple Music has been 
tweaked and refined to become even more 
user-friendly, and new features such as your 
own personal profile let you find, connect 
and share music with your family and 
friends more intuitively. In this feature  
we’ll show you how to get the most from 
Apple Music, and why it’s well worth the 
monthly investment after those initial three 
months are up. 

Apple Music
£9.99/$9.99 

 per month  
(single user)
£14.99/$14.99 

 (family account)

Get access to over 
40 millions songs to 

stream or download from 
iTunes, along with music 

recommendations, an 
always-live radio station and 

a line to the stars. 
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Build your own
radio station

1 Set the base
To start your radio station, you’ll
first need to find a base to build it
around. You can choose either a
single track or a favourite artist –
both will get you started.

2 Start a station
Tap the ellipsis button next to the
song or artist, then choose ‘Create
Station’. Apple Music will load up a
station and play you a track based
on your artist or song of choice.

3 Refine the choices
If a song pops up that you really 
love and you want to hear more 
songs that are similar, you can tap 
the Star icon on the left and choose 
‘Play More Like This’. 

Customised radio stations are a big part 
of Apple Music – you can use a song or 
an artist to create a curated station full 
of recommended tracks, sort of like a 
Genius playlist but hand-picked from 40 
million songs on iTunes, not just those 
in your library. In our tests we found the 
service to be much more accurate to our 
tastes than a service such as Spotify.

Because you now have access to over 40 
million songs, it’s probably about time you 
started making some playlists with all the 
new tracks you can listen to. And thanks to 
the iCloud features within iTunes and Apple 
Music, any playlists you create will also be 
synced between your devices – so the next 
time you pick up your iPhone or iPad, you’ll be 
able to listen to the playlist you made on your 
Mac without any fuss. It’s a brilliant system 
that takes advantage of the fact that all the 
songs are streamed – but of course you can 
download any songs you like to your Mac if 
you want to access the playlist when you’re 
not on Wi-Fi, too.

Get recommendations for awesome new tracks to try
Discover new music

1 Create a new playlist
Tap on the ‘Library’ tab and then tap on the 
arrow in the top-left corner of the screen and 
choose ‘Playlists’ from the dropdown menu 
and tap ‘New’ in the top-right corner.

2 Set up the playlist
You can now tap on the generic ‘Playlist 
Name’ text to rename it, make the playlist 
public (more later) and start adding music by 
tapping on the green ‘+’ icon.

3 Adding tracks
You can add songs from your own library 
or tap keywords into the Apple Music 
search field to find and add tracks from the 
sprawling online library.

4 iCloud syncing
Any playlists that you create on any of  
your devices will be automatically synced  
to the other devices without you having  
to lift a finger. 

Create your first playlistStep-by-step

Creating
new playlists
You can create a new

playlist using any tracks from
Apple Music. Just press and

hold on a track, choose
‘Add to a Playlist’ and

then choose ‘New
Playlist’.
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For the most part, Apple Music is a streaming
service that enables you to listen to tracks
through an internet connection, so for the
majority of time none of the music is actually
stored on your device; it simply plays from
the cloud. But as an Apple Music subscriber,
you are able to download any of the 40 million
available songs to all your devices, so if you
leave a Wi-Fi zone, or want to save some data
on your iPhone contract, you can still enjoy your
favourite tracks whenever you want.

Download songs to your
iPhone for listening anywhere

Save albums
for offline
listening

Control Apple Music with Siri
Use your voice to control your music collection

1 Find a track
Go to the ‘Browse’ section and
search for tracks that you would
like to listen to offline. When you
find one, tap the ‘+’ icon next to
it to add it to your Library.

2 Alternate method
Alternatively, if you are listening
to a track, tap on the playback
controls to go full-screen then
tap the ‘…’ icon and choose the
‘Add to Library’ option.

3 Track added
You will then receive a visual
notification that the track has
been downloaded and added to
your library. You can also delete
tracks in much the same way.

You can tell Siri to play the biggest
songs from a specific year – for

example, you can say:

“Play the top
songs from 1995”

and you’ll instantly get the top
chart hits from there.

You can ask Siri to play a specific
playlist, or a specific radio station,

too – just say:

“Siri, play my
Superorganism
radio station”

You can even ask Siri to create a
station based on any artist or track.

If you’re just not sure what it is
you’re listening to and you don’t

want to mess about touching your
screen, simply ask Siri:

“What am I
listening to?”

and you’ll instantly be told what
track is currently playing.

If you love a song that’s popped up
while you’re listening, tell Siri:

“Play more songs
like this”

and Apple Music will note that you
like it and proceed to add similar

songs to your playlist.

If you really love a song you’re
listening to and want to make sure
you can listen to it even without a
data connection, just tell Siri to:

“Add the new
Noel Gallagher

album to
my library”

If you want to listen to a specific
track, you can just request it; but

Siri is smart, so you can say:

“After this
song play Holy

Mountain”
and the track will be added to the

Up Next list.

There are a selection of pre-made stations that you can listen to within the Radio section – 
and they’ll be updated regularly by Apple.
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When an artist posts a new status, photo or video, it isn’t a
one-way conversation. Artists can share what they’ve been
doing, but Connect is all about keeping you in touch with
musicians and sharing your feedback and excitement with
them. With this in mind, Apple has made sure that you are
able to Like and Comment.

1 Like it
If you like what you see, you can literally like what 
you see. Click the ‘Like’ option to like a status or 
artist – you will be able to see how many likes the 
post has got in total above.

2 Make a comment
You can also share more detailed thoughts – click 
the ‘Comment’ option to open the Comments 
section and you will be able to add your own and 
read all of the others.

Leave likes
and comments

“Connect is all about keeping 
you in touch with musicians 
and sharing your feedback”

Get updates from the artists ou love
Connect with your favourite artists

 Share the story 
When you scroll down to the Connect 
Posts section within ‘For You’, all of the 
latest posts from the artists that you 
follow will be listed. Under each post 
will be options to ‘Like’, ‘Comment’ 
and ‘Share’. If you tap the latter option 
then you will be able to share the story 
via Mail, Twitter, Facebook or other 
selected mediums.

How to connect
You will connect with artists simply 
by adding their music to your Library 
(as long as the option is enabled), but 
you can also manually follow artists by 
tapping on ‘For You’, scrolling down 
to the ‘Connect Posts’ section then 
tapping Follow>Find More Artists…

Artist info pages
If you type the name of an artist into 
the Search field then you can access 
a main artist page by tapping on their 
name in the search results. This page 
will list their Apple Music output and 
you can scroll down the page to find 
out more information about them and 
see similar artists.

 Choose to follow 
You can also choose to follow a 
particular artist from their info page. 
Simply tap on the ‘…’ icon in the top-
right corner and then a pop-up menu 
will display several options including 
‘Follow on Connect’ – tap this and they 
will be added to your feed, accessible 
in ‘For You’.

Search
it all

You can tap the Search
option to open up the search

bar. From here you can
search all of Apple Music,
or just choose to search
through songs saved to

‘Your Library’.
It’s easy!

Music
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Personalised 
for you

Manage curated playlists

Get music 
recommendations

Access a customised music  
selection with Apple Music

Find and refine playlists to get what you want

Share music
with the world

1 Share music
No matter what you’re listening to,
you can share it. Just long-press on a
song or album and a menu of options
will appear.

2 Sharing options
Choose the ‘Share Song’ or ‘Share
Album’ option from the menu and
the usual methods of sharing will be
presented. Tap one, eg Twitter, and
you will share in-app.

You can now share your music
unlike ever before with Apple Music
– whether you’re sending playlists to
friends on Facebook or posting an
album that you love on Twitter.

1 Choose a playlist
In the ‘For You’ section, you’ll find 
a range of suggested playlists 
from the Apple Music team, as 
well as from trusted names like 
Rolling Stone, Pitchfork and Mojo.

2 Love it
Choose a playlist to start listening. 
If you like a particular song, tap 
‘Now Playing’ at the bottom of 
the screen, then tap the ‘…’ icon 
followed by the heart to ‘love’ it.

3 Add tracks
If you like a song from
then you can instantly
own library by tapping
icon next to it. It’s a g
discover new music.

m a playlist
y add it to your
g on the ‘+’
reat way to

One of the brilliant things about Apple Music 
is that it will help you find new music that 
you’ll love, based purely on what you already 
listen to. When you tell the app what genres 
and bands you like, Apple Music will make 
suggestions based on those choices – and 
they’re suggestions from people who are real 
music experts. 

Your feedback, even if you don’t like a 
song, will help to make the suggestions in 
Apple Music even better – but the system will 
also pay attention to what you play. Even if 
you don’t specifically choose a music genre, 
if you listen to it a lot you’ll start getting 
recommendations to match it.

Click or tap on the Search button and you’ll instantly be presented with a list of trending 
searches, so you can see what’s popular.
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The easy way to connect with others and share your favourite music
Create a music profile
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Music

The Music/iTunes app in iOS 11 and macOS 
High Sierra has added a new profile feature 
that lets you better connect with your family 
and friends through Apple Music and see what 

everyone else is listening to. Creating a profile 
makes you identifiable and findable to family 
and friends and lets you easily share playlists 
and the music that you are currently listening 

to. Once you have set up your personal profile, 
which we will guide you through here, you will 
then be able to click on the ‘…’ icon within your 
profile and share it with other people.

Internet
Radio

In the iTunes 12.7 interface
the ‘Internet Radio’ section

has been added to the
sidebar in Library so that you

can access your favourite
iTunes radio stations

more easily.

1 Click ‘For You’
After updating iTunes 
to version 12.7, launch 
it and click on ‘For 
You’ at the top of the 
interface. You should 
now see the ‘Start 
Sharing with Friends’ 
flash in the top-right 
corner – click on this.

4 Choose  
who follows
By clicking ‘Next’ your 
details will be checked 
and if your username/
handle is already in use 
then you will have to 
enter a different one. 
Next, choose who can 
view your activity.

2 Get Started
Now click on ‘Get 
Started’ on the pop-
up and you can enter 
information into your 
own personal profile. 
Your name should 
already be entered so 
add a username to 
accompany it.

5 Find and  
follow friends
You will be invited to 
sign into your various 
social media accounts 
to find people you 
know and tailor your 
iTunes notifications. 
Once you have 
finished, click ‘Done’.

3 Add a photo
Click on the round 
photo icon and then 
select a location to 
obtain an image from in 
the left-hand column. 
Choose ‘Camera’ and 
you can take a new 
picture through your 
Mac’s camera.

6 Good to go
Your iTunes profile will 
now be all set up and 
whenever you click  
on the ‘For You’ tab,  
it will display your 
profile information 
along with the music 
that you have recently 
listened to. 



Pick the perfect streaming service for your tastes
Which streaming service is right for you?

Apple Music
£9.99/$9.99 per month

£14.99/$14.99 per month (family plan)

Three months free
Every iPhone, iPad or iTunes user can get a free
trial of Apple Music for three months, which is

completely unlimited. This means you can listen
to all the music you want for 90 days without

having to pay up – and at the end if you decide to
take the plunge, all your settings and choices will

remain in place.

Get it anywhere
Thanks to the power of iCloud, all your choices

will be synced to all your devices. So if you create
a new playlist or radio station, it will appear

instantly on all your other devices. And with an
Android app also available, even those without

iPhones can enjoy the power of the
Apple Music library.

All the family
One of Apple Music’s biggest advantages is the

ability to share a subscription with up to six family
members. If you already have Family Sharing set
up within iCloud, when you start an Apple Music
subscription they will also get all the benefits for

just £14.99/$14.99 a month.

Audio quality
The only downside of Apple Music compared to
competitors is that the audio quality is slightly

lower when streaming. While Google Play Music
and Spotify offer 320Kbps quality, Apple Music is

just 256Kbps AAC audio.

Spotify
£9.99/$9.99 per month,

then £5/$4.99 per extra user
Playlist perfect

One of Spotify’s biggest strengths comes in its
playlists. Spotify is built around playlists, and
creating them is incredibly simple. When you
create a playlist, it will be synced across all of
your devices, so no matter what device you’re

using, the tracks you want are always available.

Beat-matching
One of Spotify’s brilliant, and relatively new,

features is its ability to track the number of steps
you’re taking per minute when you go for a run

with your iPhone. It can track the beats, and
match tracks to your speed, giving you a smooth

rhythm when you’re exercising.

Free with ads
Spotify is the only one of these three that offers
completely free listening to the full library – as

long as you’re willing to listen to an ad every now
and then. You can sign up for an account for free,

and don’t have to pay a penny unless you want
ad-free listening (and Spotify’s other benefits).

No music videos
While Google has YouTube integration, and

iTunes has the Connect section to show off the
latest music videos from your favourite artists,
Spotify sadly doesn’t offer any music videos at

all. You’ll have to make do with the other options
built into the app and head to YouTube for

ad-supported music videos.

Google Play Music
£9.99/$9.99
per month

Free curated radio
Google Music requires a monthly subscription,
but Google recently announced that anyone will
be able to use its curated radio stations for free.

These function much like Apple’s – pick a song or
artist and the app will create a station for you. An
ad or two will play, then you can start listening.

iTunes compatibility
You can use a small Google plug-in on your Mac
to sync all of your iTunes music to Google’s cloud

storage. The tracks will then be added to your
library, and you’ll be able to access all your tracks

through Google Play Music on your phone or
other device – no more iTunes required!

YouTube Music Key
Along with your monthly subscription to music,
you will also unlock YouTube Music Key. This
enables you to play millions of music videos
for free, and keep their music playing in the

background while you do something else on your
phone, or even play offline.

Trial minimum
This is where Google comes last; while Spotify

offers a 60-day trial and Apple’s three-month trial
period beats even that, Google’s trial is just a
measly 30 days. This means that you only get

a month of free music to decide whether or not
you want to continue with the service and shell

out for the monthly cost.

When people ‘follow’ you in Apple Music, click on their profile pictures to see what they 
have been listening to recently. 
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Make music anywhere
Tap, test and play with Medly

iPhone X

 The background
Using this simple icon you can change 
the tempo of your track, the key, scale 
and much more. Create the track first 
and then make these adjustments later 
for a more rounded effect.

 Moving instrumentation
You can use these tabs to move parts 
of the song and to change instruments 
as required. The multiple layers come 
together well to help you build complex 
and beautiful music on your iPhone.

 Tap to place
Simply tap on the grid to place a new 
note. You can then move it, elongate 
it and continue to add notes using just 
your hearing to understand what should 
go where. It really works.

Get Creative with
your iPhone X

Creative computing has for a long time been the domain of the 
desktop with the requirement for powerful processors and large 
screens being paramount in the minds of many creative people. 
Computing has grown in power and shrunk in size over the past 
decade, however, and the iPhone X is the culmination of Apple’s 
ambitions which have reached the level where you can create a 
variety of things in the palm of your hand without the hardware 
ever getting in the way. The results are entirely professional and 
look like they have come from a powerful desk computer, but 
most of all app developers have given you all of the tools and 
ease of use you need to build anything from scratch in a variety of 
imaginative ways. You may be surprised at what is available.

You can create magnificent things  
with an iPhone X

1  Professional 
home videos

ovie is an iconic movie editor 
m Apple which when utilised 
the powerful and capacious 
one X is capable of letting you 
ate professional-quality movies 

d trailers with little knowledge 
uired. The end results are 

most always better than you  
y expect.

2  Create a logo
Logo Maker-Logo 

eator takes the process of 
ating a logo for a website or 

y other project and makes it as 
mple as can be. You are offered 

ariety of designs within the 
ge iPhone X display to gain 
ntext and then you can add your 
sonal touches. Child’s play.
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The vast majority of iOS apps will offer 95 per cent of what their Mac 
equivalents offer, only in a smaller and more touch-centric manner.

3  Develop 
stunning images

Pixelmator is a professional-grade 
image editor that offers a selection 
of powerful tools including special 
brushes, artwork capabilities and 
layer management within an interface 
which suits the large iPhone X screen 
perfectly. For stunning images, this is 
the best tool.

6  Write a novel
Ulysses is a subscription

based service and app which lets you
write novels, essays and longer piece
in one place. You can create eBooks
from your work and most importantly
you get to work in an environment
which takes away all of the visual
distractions instantly.

7  Make  
sweet music

There are countless music creation 
apps on the App Store, but Medly is 
a good example of a tool that works 
particularly well on the iPhone X.  
The big layout lets you visually see  
the scope of your tracks and the 
actual creation process is set  
perfectly for originality.

8  Cook  
beautiful food

With Kitchen Stories you can learn 
new recipes and cook beautiful food 
in minutes using the simple and very 
well-presented instructions. You can 
then take the ideas and experiment 
to educate yourself in the ways of 
offering new and delicious meals 
every single day.

9 Build a website
Weebly lets you build 

and update a website on just your 
iPhone X. You can design everything 
using drag and drop and then create 
an online store to monetise your 
online presence. The results look 
professional and could potentially start 
a lucrative venture for you.

10 Create 
anything

The more you search, the more 
creative apps and uses you will 
discover for your iPhone X. From 
presenting beautiful quotes, which 
Quote Maker is perfect for, to doing 
almost anything else with images, 
music, art and text, there will be many 
solutions available to you.

4  Capture 
perfect moments

The iPhone X camera is pretty 
special, but it is designed to allow the 
simplest experience. If you download 
Manual, however, you can control 
the shutter, ISO, focus and exposure 
compensation and then save the 
photos in RAW PNG. Your photos will 
look better than ever.
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5  Sketch  
and paint

Who would have thought that you 
could create original artworks 
from just your phone screen? Well, 
download Adobe Photoshop Sketch 
and you will be amazed at how 
powerful the tools are and how easy 
they are to use on an iPhone X. It’s a 
mini canvas that’s always with you.
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Clips

Share your virtual worldStep-by-step

1 Use the classics 
When you open and mess around with the 
features within Clips, you should take some 
time to experiment with the filters on offer. 
There are many options to play with. 

2 Add some extras 
You can also add emojis, stickers, labels 
and have the app automatically subtitle what 
you are saying within the video clip. The end 
results are impressive. 

3 Be somewhere else  
If you are using an iPhone X, tap ‘Scenes’ 
and scroll through the options on offer. For 
some, such as ‘Mega-Destroyer’, you will see 
your face with a green screen effect. 

Time needed

Difficulty

Enjoy iPhone X 
enhanced Clips 
Clips lets you express yourself in many ways and 
with the iPhone X you can take things even further

10

Apple developed Clips to take special effects in social videos to 
a whole new level and there is no doubt that the app achieved 
that instantly. However, this has now been taken even further 
with the launch of the iPhone X and some dedicated special 
effects that are truly spectacular when time is taken to create 
them, and which take full advantage of the camera capabilities 
in Apple’s flagship phone. Here we’re going to take a closer 
look at what’s now possible in Clips…
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Live Titles are particularly enticing. As you speak you will see the words 
printed onscreen in the exact font you want to use.

4 Step back 
Unlike most videos you make with Clips, you 
will need to step back a bit using scenes to 
let the background work in context. Some 
scenes look extremely realistic. 

5 360 degrees 
Remember that these scenes offer a full 360 
degree experience so try to move around 
while capturing a clip. It will make the video 
much more fun for the viewer to watch. 

6 To the limit 
Anyone can share video clips on any social 
network. Clips is there to let you use your 
imagination to create something unique so 
don’t be afraid to experiment a little. 

A visual feast
Complex features simplified

 Just one clip 
Try to only create one clip at a time 
to keep the experience positive and 
timely. There are more than enough 
tools to make each clip unique. 

 Simplicity works 
Just because you have an iPhone X does 
not mean you need to use Scenes every 
single time. The ‘Posters’ offer a selection 
of entertaining backdrops to work with. 

 Knowledge base

In the detail
There are typical Apple touches throughout Clips. 
It can recognise who you share videos with most 
often, and even who is in the clip so that they will 
be presented first for the quickest possible sharing 
experience. The entire focus is on creation and as 
such it is a perfect example of Apple usability. 

 Real-time previews 
Everything you do in Clips is displayed in real time 
so that you can be sure the end result will be worth 
sharing. It really is great fun to use. 

 Static media 
The static media works well to offer a contrasting 
clip that will appeal on multiple levels. Use the 
features that work with the subject matter of the clip. 
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Dow load available

Time needed

5

Difficulty

Review and cancel 
your subscriptions 
and memberships

Many of you will have taken out a subscription to a service 
only to find you don’t use it that often. You really should 
cancel any you’re not taking full advantage of – here we’ll 
show you how to amend your Apple Music, Spotify or Apple 
News subscriptions, for instance, while putting a stop to 
little read newspaper subs and ongoing payments to apps. 
Don’t hesitate. Some subscriptions renew if you don’t 
cancel within 24 hours of the renewal date, forcing you to 
pay for that extra period.

Are you paying monthly for services that you are not 
using? Apple lets you manage and cancel them

View and cancel your subscriptionsStep-by-step

1 Open Settings app
In order to view your subscriptions and make 
amends to them, you first need to go to the 
Settings app and click your name which you’ll 
find at the top of the main screen.

2 Select App Store
Tap the entry for iTunes & App Store. On the 
next page, you need to tap your Apple ID. 
Make sure it is the ID associated with the 
subscriptions that you want to manage.

3 View Apple ID
A pop-up window associated with your 
Apple ID will now appear. Select the option 
‘View Apple ID’ at the top and sign in either 
using your password or using your Touch ID.

Settings
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How to 
manage your 
subscriptions
It pays to keep an eye on  
your subscriptions to avoid 
paying or overpaying for 
underused services

 Cancel subscriptions
As we noted in the main tutorial, you can click 
‘Cancel’, in which case you will be bringing the 
current subscription to an end.

 Viewing subscription details
At the top of the Settings page for each 
subscription or membership, you will see details 
of your current terms. Here, for instance, we see 
we have a monthly subscription to Apple Music 
at £9.99.

 Payment tiers
You may decide you want to keep the 
membership but move to a different tier of 
payment. If this is the case, then you can select 
a different option here.

 Note the date
The date will tell you when your actions will take 
place. Change the payment tier and it will come 
into effect after that day. Cancel and you’ll be 
able to access the sub until that day.

 Knowledge base

Subscriptions not showing?
You may not see details of some of your ongoing 
subscriptions. Perhaps you were expecting to 
see Netflix appear but it’s nowhere to be seen. 
If this is the case, then it’s more than likely you 
will have signed to the service direct rather than 
through iTunes or an app. In that case, you will 
need to go to the company’s website, log in and 
cancel or amend from there.

4 Go to Subscriptions
This next page details information associated 
with your Apple ID. In order to view your 
subscriptions and memberships, scroll down 
and select the entry marked ‘Subscriptions’.

5 Check your subs
You can now see any subscriptions that you 
have active along with any that have expired. 
It is possible to resubscribe to lapsed subs 
and cancel those you don’t want any more.

6 Select a sub
By tapping on a subscription, you can view 
its current terms and see any available 
payment tier options. Tap ‘Cancel’ to bring it 
to an end. It will then appear under Expired.

If you change your mind after cancelling a subscription, find it in the expired 
section, tap it, and reactivate by selecting a payment option on the screen.
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Settings

Save your roaming data allowanceStep-by-step

1 Disable Wi-Fi Assist
Go to Settings>Mobile Data and scroll down 
to see if the ‘Wi-Fi Assist’ feature is on. This 
utilises your mobile network if your Wi-Fi 
coverage is poor so be sure to turn it off.

2 Stop apps
Listed in the Mobile Data section in Settings 
are all of the apps that use mobile data. If 
you are getting close to your limit, go through 
the list turning off all non-essential apps.

3 Turn off Auto-Play
Facebook has a feature that auto-streams 
videos as you scroll through your timeline. In 
the app, go to Settings>Videos and Photos 
and change to ‘Never Auto-Play Videos’.

Time needed

Difficulty

Preserve your 
iPhone roaming data
Is your mobile data being eaten up far too soon? The
take these quick and easy steps for making it last lon

5

Many of us are on mobile phone contracts that only permit a f
amount of roaming data usage a month, and if you use up thi
allocation then you will either have to purchase more or do wi
roaming data altogether for the rest of the month. Thankfully t
are may ways in which you can make adjustments to your iPh
settings to help preserve your data allowance and make it stre
further, such as disabling push notifications and background a
refresh. Rather annoyingly, many of the options and settings t
eat into your mobile data are enabled by default and lay tucke
away deep within the Settings app so that they are easily miss
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Twitter and Instagram also have Auto-Play options so open up the 
respective apps’ settings and disable them to preserve your roaming data.

4 Stop fetching mail
Having your iPhone automatically search for 
new emails can consume your data. Go to 
Settings>Accounts & Passwords>Fetch New 
Data and turn off ‘Push’.

5 Stop apps refreshing
You also don’t want apps refreshing content 
in the background. Go to Settings>General> 
Background App Refresh and either turn it off 
completely or limit it to key apps.

6 Turn off Push Notifications
Take measures to stop your apps from 
sending you needless notifications. Go to 
Settings>Notifications and you can determine 
which apps notify you and how.

Mobile data tips
Options to be aware of within 
your Mobile Data Settings

 Reset data
It is good practice to get into the 
habit of resetting your mobile data 
statistics (preferably on the day 
that your data allowance resets) to 
accurately monitor your usage.

 Monitor data usage
Keep tabs on how much data you are using by 
going to Settings>Mobile Data and checking your 
current period to get an idea of how much you 
are using, then you can start making restrictions.

 iCloud Drive 
If you are short on data then forget 
about using iCloud Drive while out and 
about. Turn off the option here and  
make sure you turn off options such as 
Photo Stream too.

 Knowledge base

Use Reading List
Many of us use up mobile data by reading stories 
on the web during work commutes. However, if you 
get up five minutes earlier, access your favourite 
news site, tap on the stories that you want to read 
and then hit the share button, you can then use the 
‘Add to Reading List’ option to store offline versions 
of the stories.

 Wi-Fi Assist
This pesky option can be extremely 
detrimental to your data as it calls on 
mobile data to strengthen the signal of 
poor Wi-Fi coverage. Just turn it off and 
move to find better Wi-Fi coverage!
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Dolphin Browser

Listen to songs via YouTubeStep-by-step

1 Download Dolphin
The ability to play YouTube videos in the 
background of an iDevice only works via the 
Dolphin browser app. Install it from the App 
Store (search Dolphin Browser) and open it.

2 Visit YouTube site
Type youtube.com into the address bar 
and decline any attempts to take you to the 
YouTube app. Now search for a song and 
tap it. When you’re ready, press Play.

3 Background play
Press the Home button (or swipe on iPhone 
X). View the Control Centre by swiping up 
and you’ll see the name of the song. Tap Play 
to resume the song in the background.

Time needed

Difficulty

Play a YouTube video 
in the background
You are able to play songs from YouTube while you 
get on with other tasks on your iPhone or iPad

2

YouTube has a streaming service that, among other things, lets you 
play the audio of any video in the background of a mobile device. 
The downside is you have to pay for the service and, while it is 
available in the US, it hasn’t yet reached the shores of the UK. The 
good news, however, is that there is another way to stream music in 
the background on your iPad and iPhone. What’s more, this method 
is free. To get it to work, you must download the Dolphin Browser. 
That’s because the technique used to work with Safari but Apple 
patched it away. It means there’s every chance pressure will be 
placed upon Dolphin to do the same. Until that day, though, you can 
stream away and do other stuff, which is music to our ears.
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Your WhatsApp settings
Essential things to know

WhatsApp

 Data and Storage Usage
If your iPhone operates on a strict data 
limit then it is worth tapping on this 
option to limit all media downloads to 
Wi-Fi only, thus preserving your data for 
more important things.

 Chat options
This is where you go to change your 
chat wallpaper and back up your chats. 
Also, it is worth noting that photos 
shared on WhatsApp are shared to your 
Camera Roll by default, so you can 
disable that here too.

Starred messages
When you press and hold on a message
and tap the star icon it will be saved to
this very section. Great for key info and
handy dates, all of the messages you
‘star’ will be listed here.

 Account info
This is where you will find various options 
relating to Privacy, Security and more. 
You can disable the read receipts (blue 
ticks), share your location and block 
contacts in the Privacy section.

“You can have group chats, send 
media and more, but even 
hardcore users may not know the 
full extent of what you can do”
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10 must-know WhatsApp secrets
WhatsApp is a brilliant free app that makes it quick, easy and fre
to communicate with other people, regardless of what smartpho
platform they are using. In WhatsApp you can conduct group
chats, send media and much more besides, but even hardcore 
WhatsApp users probably don’t know the full extent of what you
can do with it – so we figured it was high time we delved a little 
deeper to unearth some meaty secrets.

Here we show you how to change your chat background, how
to save dates, how to bookmark messages and even how to
disable those infernal blue ticks… so read on to become a true 
WhatsApp genius!

Things you probably never knew you could do in the popular messaging app

1  Hide the blue ticks
Enabled by default, the blue ticks show 

everyone else that you have read the message 
– but if you don’t reply instantly it can cause 
resentment. To hide the blue ticks go to 
Settings>Account>Privacy and then turn off the 
‘Read Receipts’ option. They are always sent for 
group chats, though.

2 Hidden text formatting
If you want to place more emphasis on 

certain words then you can bold them out or add 
italics or strikethroughs. To make a word appear 
in bold, simply add a ‘*’ either side of it (eg: 
*star*), to italicise a word place an underscore 
(‘_’) either side and for a strikethrough add a ‘~’ 
either side.

 Knowledge base

Broadcast messages
If you want to send the same message to a group 
of friends without it being an actual group chat (and 
everyone being privy to everyone else’s responses) 
then you can by going to Chats>Broadcast 
Lists>New List and then adding in the various 
contacts. Any messages you then send to the 
group will appear as though you have sent it to 
them individually.
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If your message has a blue tick then press and hold on it and swipe to the 
left. You will then see the exact time it was read.

5  Preserve your data
If you are on a limited data 

plan and don’t want WhatsApp 
media eating into your precious data 
allowance then it’s a good idea to  
go to Settings>Data and Storage 
Usage, and then under the ‘Media 
Auto-Download section you will be 
able to switch between ‘Wi-Fi and 
Cellular’ or just ‘Wi-Fi’ for your  
media downloads.

6 Hide previews
If you are showing someone

something on your iPhone then the
last thing you want is for a rude
WhatsApp message preview to
appear onscreen! Luckily, as with the
Messages app, you can turn this off by
going to Settings, then Notifications>
WhatsApp and either turning off
Notifications or scrolling down and
setting ‘Show Previews’ to ‘Never’.

7 Bookmark your
important messages

If certain WhatsApp messages contain
important details that you would like
to remember then simply long-press
on the specific message and then tap
on the star icon. This will bookmark
the message so that you can jump
to it quickly and easily by going to
Settings>Starred Messages.

8 See recent
You can see when yo

unread messages from W
contacts without opening t
thanks to iOS 11. Swipe rig
your Home screen, scroll t
your widgets and then tap
can now add the WhatsAp
Chats’ widget by tapping t
icon. You can then swipe r
your Home screen to acce

9 Access
quick features

In iOS 11 you can also access quick
features of WhatsApp using 3D
Touch. If you have an iPhone 6s or
above then you can press down hard
on the WhatsApp icon and access
key features such as Recent Chats,
Camera, Starred Messages and more.
Tap an option to jump straight in.

10 Hide yo
profile pictur

It may be that you have be
to a new group and you do
everyone included to be ab
profile picture, but you can
quickly and easily enough.
Settings>Account>Privacy
on the ‘Profile Photo’ optio

4  Save dates
Certain aspects of WhatsApp are

woven into iOS 11. For example, you
can send WhatsApp messages using
Siri and, if someone sends you a date,
you can add it to your Calendar app.
To do this, simply press and hold on
it and the ‘Create Event’ option will
appear – tap on this and then give
the go ahead for WhatsApp to access
your Calendar.

3  Change your  
chat wallpaper

If you fancy sprucing up your 
WhatsApp chat backgrounds then 
go to Settings>Chats and tap on the 
‘Chat Wallpaper’ option. You will then 
be able to peruse different options 
from the Wallpaper Library or choose 
a solid colour. If you want to get really 
personal then tap on ‘Photos’ and pick 
one from your gallery.
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Apple Watch

Activate and use Time TravelStep-by-step

1 Open Watch app
The Time Travel option is turned off by 
default. To activate it, you must first open the 
Watch app on your iPhone and tap the ‘My 
Watch’ icon at the bottom of the screen. 

2 Select Time Travel
Scroll down the screen until you reach the 
list of apps installed on your Watch and tap 
‘Clock’. You’ll now see an option for Time 
Travel. Tap to ensure this is turned on.

3 Grab your Watch
Turn your attention to your Apple Watch 
and go to your Watch face. It will display the 
current time. But, as long as it allows it, you 
are ready to go back and forth in time.

Time needed

Difficulty

Travel back and forth 
in time on Apple Wa

Your Watch is capable of many things: making and receiving
phone calls, checking messages, playing music and keeping
an eye on your health. But did you know it was also capable
time travel and that all you need to do is twist the Digital Crow
back and forth to achieve it? We’re not pulling your leg either

Now, there are limitations of course: you’re not about to tu
Marty McFly and physically go back to the future. What you c
do, however, is move the time and date forward and back on
your Watch. Anything that would have been displayed at thos
times will then be shown.

This is great for seeing what’s in store in terms of your
calendar events, reminders and weather. You can also look a
what has gone by in the recent past. There is even a chance
for some fun thanks to a neat little feature that lets you intera
with the phases of the moon or the position of the sun and
planets. Here’s how it works…

Want to see what lies ahead or what has gone past?
Forget time machines and check your Watch instead
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When you are done going back and forth in time, just press the Digital 
Crown and the watch face will go back to the present.

See the phases  
of the moon
Time Travel is a particularly 
effective and fun feature 
when you are using the 
Astronomy watch face

 Moon and planets
Before you touch the Digital Crown, this bottom-right 
space will show the Solar System. Tapping it will let you 
see the changing position of the planets. A button bottom-
left will also let you see the future phases of the moon.

 Select Astronomy
For this to work, you need to select 
the Astronomy watch face. You will 
find this by pressing and holding on 
your watch face before swiping left or 
right. Tap to select it.

 Earth rotation
As you go back and forth, note the exact 
time top-left and also marvel at how the 
Earth rotates and shows the position of 
the Sun through its depiction of light  
and dark.

 Knowledge base

Selecting a perfect watch face
Not all watch faces work with Time Travel and some 
are also more ideal than others. So figure what 
you want to do with it and then ensure your clock 
face has that particular complication. For example, 
if you want to be able to cycle back and forth in 
time to view your calendar, make sure the Calendar 
complication is available and active.

 Going forward
Turn the Digital Crown forward and you’ll 
see how many hours or days ahead you 
are by simply looking at this indicator in 
the bottom-left corner.

4 Turn the Crown
We are going to attempt to go forward 
through time. To do this, turn the Digital 
Crown forward. The screen will tell you how 
far you’ve gone and display the future time.

5 Go back in time
To go back in time – virtually at least – you 
will need to turn the Digital Crown in the 
opposite direction: that is, backwards. Again 
the screen shows the adjusted time.

6 View the Complications
If there is any information within the 
supported complications, whether it’s 
calendar events, weather or reminders, these 
will show as you go back and forth.
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Customise your notification settingsStep-by-step

1 Launch Watch app
If you want to manage your Apple Watch 
notifications, you need to do so within iOS. 
Open the Watch app on your iPhone, select 
the My Watch tab and tap ‘Notifications’.

2 Adjust built-in apps
The screen is split into two app sections. 
The first caters for apps that are built into 
watchOS such as Breathe, Mail, Maps and 
Clock. The second lists third-party apps.

3 Select an app
Let’s deal with the built-in apps first. Select 
an app (we’ve chosen Activity) then view the 
list of potential notifications and switch the 
green sliders ‘off’ to deactivate.

Time needed

Difficulty

Manage your notifications 
on Apple Watch
Stop your wrist from buzzing too often by altering
the notification settings of the apps on your Watch

5

Your Apple Watch is meant to keep you informed. That 
means you are told when any phone calls, emails or texts 
are arriving on your iPhone and it is why you are alerted to 
notifications from the various apps you have installed. But 
that’s not to say the alerts can’t become a nuisance. 

Every app on your Watch lets you turn off the notifications, 
but what if you want to tailor the alerts to better suit your 
needs? Here things get trickier since the built-in apps have 
customisation options but the third-party apps do not. For 
these you need to decide if you can do without their alerts. 

Apple Watch
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Having problems seeing notifications? They won’t appear if your iPhone is 
unlocked, if your Watch is locked or if you have Do Not Disturb turned on.

4 Customise notifications
Most built-in apps have two main options: 
Mirror my iPhone (mimicking whatever 
notifications are set up in iOS) and Custom. 
Choose the latter to make bespoke changes.

5 Alter the alerts
As before, move the green sliders to ‘off’ for 
the options which appear. Typically you can 
choose not to show alerts and decide if you 
want sound or haptic notifications.

6 Third-party apps
With third-party apps, you can only stop 
notifications from mirroring the alerts received 
on your iPhone. Go down the list and switch 
them on and off with the green sliders.

Hide the 
content of 
notifications
Ensure that alerts are for your
eyes only by preventing them
from showing their content as
you raise your arm

 Tailor your calendar
Since the Calendar app can bombard 
you with notifications, you may want to 
pay particular attention to it. Tap it here to 
customise alerts such as upcoming events 
and invitations.

 Stop backup encryption
Want to hide the fact you’ve received a 
notification at all? You can go as far as 
removing the red dot on the watch face 
simply by swiping this switch to turn it off.

 Notification Privacy
By moving this switch to green, the only 
thing you will see when you receive a 
notification is the alert itself. The content 
of it won’t show, hiding sender details or 
text, for instance.

 Knowledge base

Customising third-party alerts
You can’t customise Watch alerts for third-party 
apps. By default they mirror your iOS alerts and 
can only be switched off (there’s no way of having 
different alerts on your Watch to those on your 
iPhone). But you can make a useful tweak by going 
to the Settings app on iOS, tapping Notifications 
and selecting an app. By turning off sounds, you 
can prevent the Watch from making a noise or 
vibrating when an alert arrives on the Watch screen.

 Notification page
All of your notification settings are on 
this page which you can reach in the 
Apple Watch app on your iPhone by 
going to My Watch>Notifications.
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Clear space on Apple TVStep-by-step

1 Open Settings app
In order to see how much storage space is 
being used by each of your installed apps, 
you must start by launching the Settings app 
on your device and selecting ‘General’.

2 Find Usage section
Scroll down the screen until you almost reach 
the bottom. There you will see the option 
‘Manage Storage’ within a section marked 
Usage. Select this to open your list of apps.

3 View your apps
The list shows every app you have installed 
from the App Store together with how much 
space they are taking up. Each is ordered 
according to size, with the largest at the top.

Apple has taken a couple of steps to maximise 
the amount of storage space you have on your 
Apple TV. Firstly, it only stores apps on your 
device: video and music are always streamed. It 
has also placed a 200MB limit on the apps you 
download, meaning data beyond that is stored 
in iCloud to be retrieved when needed and 
removed locally when finished with.

This is a great move but it can present you 
with a problem. If you don’t have enough space 
on your device, then that extra data can’t be 
downloaded in the first place. Ensuring there is 
plenty of room is therefore rather useful but how 
do you discover how much space each of your 
apps is taking up so that you can prune them 
more effectively? By delving into Settings, of 
course, as we show you here.

Manage your Apple TV storage
Worried that your apps are eating away at your Apple TV’s storage space? 
Then here we show you how to identify the worst offenders and remove them

“Apple has placed a 200MB limit on 
the apps you download, meaning data 
beyond that is stored in iCloud”

5
Time needed

Difficulty

Apple TV
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Check how much space is left
Apple TV tells you how much space your apps are using but it doesn’t 
tell you how much space is left. For that you must buy a third-party app

 Total Space
This is a nice reminder of which 
Apple TV you went for: 32GB or 
64GB. We can’t help but feel that 
Apple should be including all of this 
info in Settings, though.

 Free Space
You can also see how much space 
you have to play around with. This is 
useful if you download an app that 
needs lots of additional resources.

 Used Space
The tvStorage app lists how much space 
you have used while also showing you 
what it equates to as a percentage of 
your overall system.

Remember, you are only able to remove apps that you have installed. 
Apple’s stock apps can’t be deleted.

 Knowledge base

Home screen deletion
Apps can also be deleted directly from the Apple TV 
home screen so if you spot an app that you never 
open you don’t have to open the Settings app to 
remove it. Instead, select the app before pressing 
and holding on the remote’s Touchpad. The app will 
begin to wiggle. You can now press the Play/Pause 
button and select ‘Delete’.

 Download tvStorage
We found two apps that tell you how 
much space remains on your device: TV 
Storage Info and tvStorage. Both cost 
99p/99c but we went for the latter.

4 Identify unwanted apps
Look at the apps and identify those you rarely 
open. Select the trash icon next to an app 
you don’t want to keep and confirm you wish 
to remove it by selecting ‘Delete’.

5 Repeat the process
The app will be removed along with any 
other app that uses your iCloud Home 
screen. If you wish, you can now find another 
unwanted app and do the same.

6 Reinstall an app
Don’t worry about deleting apps. If you make 
a mistake or decide you want it back later, 
just go to the App Store. Previously bought 
apps can be downloaded again for free.



Genius Bar
Our Apple devices and the software on them are some of the finest 
products on the planet, but even they have their moments. We’re here 
to give you expert advice and get you back up and running in no time

I have heard that there are secret menus and options hidden
away in Safari. How can I access these? Sean O’Grady

3D Touch
Touchscreen technology
first introduced with the
iPhone 6 and 6s Plus
that lets you access new
features depending on
how hard you press down
on the screen.

4K
This is a new type of TV
and monitor standard
that is replacing HD and
is so-called because it
will have around 4,000
horizontal pixels. Although
actual resolutions vary,
the most common is
3840x2160.

Apple Script
Easy-to-learn macOS
programming language
created by Apple to help
automate programs.

Bluetooth 4.0
This incorporates a
low-power standard
which means that it can
be activated and left
on without causing a
significant drain on your
iPhone’s battery. Also
applies to AirDrop.

Go to your Safari
Preferences to enable the
hidden Develop menu…

1 Go to Preferences
Click on the ‘Safari’ menu and
then choose ‘Preferences’. Click
on the ‘Advanced’ tab and then
tick the option marked ‘Show
Develop menu in menu bar’.

2 Fix websites
In the new Develop menu you will
discover a wealth of new options,
including one to ‘Empty Caches’,
which is handy for when you’re
having problems with a site.

3 Disable images
You will also find other options, 
such as one to ‘Disable Images’. 
If you regularly visit image-heavy 
sites then enabling this option is a 
good way to speed them up.

The place to 
come for key 
terms made easy 
to understand 

Glossary

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Instagram
icreate_mag

Email
icreate@futurenet.com
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The one-stop
column for 
Genius advice
I seem to remember 
hearing that iOS 11 
would automatically 
decrease the size of 
photos and videos 
that you capture on 
your iPhone to free up 
more storage space. 
However, so far I haven’t 
really noticed much 
difference. Why is this?
The new HEIF/HEVC 
format isn’t actually 
applied to your images 
by default. Instead you 
have to go to Settings> 
Camera>Formats and 
then tick the ‘High 
Efficiency’ option. 
Staying with the ‘Most 
Compatible’ format 
option will continue to use 
JPEG/H.264 formats.

Since updating my 
iPhone to iOS 11 
it is having trouble 
connecting to my 
Bluetooth headphones. 
What can I do to rectify 
this problem?
Try going to Settings> 
Bluetooth and tapping on 
the blue circle icon next 
to your previously paired 
headphones. Now tap 
‘Forget This Device’ and 
then try reconnecting. If 
that doesn’t work, go to 
Settings>General>Reset 
and then select the 
‘Reset Network Settings’ 
option. In doing this all 
Bluetooth connections 
will be forgotten by 
your device. Now try 
reconnecting to see if this 
resolves things.

Apple 
Expert

I would like to share documents from my iOS 11 Files app – 
how do I go about doing this? Mandy Suttcliffe

 Allow for changes
By selecting ‘Can Make 
Changes’, all of those permitted 
by you to access the document 
will be able to edit and print it.

 View only
This option still allows the people that you 
are sharing the documents with to print 
the document out, but they will not be 
allowed to make any changes to it.

 Granting access
If you select this option then 
only the people you invite 
can access your document 
by signing into iCloud using 
their Apple IDs. The other 
option allows anyone with a 
link to access it.

 Sharing files
In your Files app, navigate to the 
document that you would like to 
share and then press and hold 
on it until a menu appears above. 
From the menu, tap the ‘Share’ 
option and then on the next 
screen you should see the option 
to ‘Add people’ in the lower row 
of icons. Add the details of the 
people to share with and then 
tap ‘Share Options’ to get to this 
screen of options.

I have heard that it is possible to save iPhone websites as PDFs, 
which would be good for my portfolio. How do I do this? Tim Binns

3 Save the page
When you are happy, tap ‘Done’ 
and two options will appear, one 
to delete the PDF and the other 
to save it. Tap to save and then 
choose a destination for the PDF.

2 Swipe to options
When the share options are 
displayed, swipe to the left over 
the bottom row of icons and 
choose the ‘Create PDF’ option. 
The page will show as a PDF.

1 Tap to share
Open Safari on your iPhone 
and navigate to the page that 
you want to share. Once it is 
displayed, tap the share button 
at the bottom of the screen.
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Remember that you can annotate PDFs on your iPhone. Just tap on the pen 
icon at the top of the screen and you can go to town marking them up.
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column for 
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My Mail app is 
constantly showing 
that it is downloading 
messages in the activity 
pane. This has been 
going on for a few 
weeks. Is there any way 
to stop this?
Start off by clicking on 
the ‘Window’ menu bar 
item within the Mail app 
and select ‘Activity’. This 
will bring up an activity 
monitor that will show 
if any messages are 
currently downloading. If 
this is clear then it may 
be time to rebuild and 
reindex your Mailbox. 
Start off by clearing your 
Junk and Trash mailboxes 
and then click on the 
‘Mailbox’ menu bar item 
within the Mail app and 
select ‘Rebuild’. You 
will need to do this for 
each mailbox and the 
process can take hours, 
rendering your Mac less 
responsive than usual. 
As a last resort, you 
can try reindexing your 
mailboxes. To do this, 
quit the Mail app and 
then hold the Option key 
and in Finder choose 
Go>Library. Now navigate 
to Mail/V2/MailData 
and remove any file that 
begins with ‘Envelope 
Index’ and place it in a 
separate folder on your 
desktop. Now relaunch 
the Mail app and it will 
build new Envelope Index 
files. This takes a bit of 
time but should fix the 
problem eventually.

Apple 
Expert

How can I create a new, custom face for my Apple Watch? I 
want to use one of my own photos… Carrie Newman

 Select your photo
Open up your Photos app and 
navigate to the image that you 
would like to use, then tap on 
the Share button and swipe 
through the bottom row of 
sharing options until you see 
‘Create Watch Face’. Tap this.

 Photos face
You will be presented with 
two choices – select the 
‘Photos Watch Face’ and 
your chosen image will be 
displayed full screen. You 
could also try going for the 
‘Kaleidoscope Watch Face’ 
option for something a bit out 
of the ordinary…

 Other options
You will also see various other 
options on the page relating to 
your custom watch face, such 
as positioning the time display. 
Select ‘Top’ or ‘Bottom’ to help 
ensure no key detail is obscured.

I know for a fact that there are hidden symbols that I can 
type on my Mac but I have no idea how to access them. Is 

there any way to see all of the characters that I can type without 
having to resort to trial and error? Craig Rand

There certainly is. Go to System Preferences and click on the 
Keyboard pane. Under the general ‘Keyboard’ tab of options you 
will see one called ‘Show keyboard and emoji viewers in menu bar’. 

Click to enable 
this and then 
whenever you 
need to type 
a symbol, 
click on the 
keyboard menu 
bar item and 
choose ‘Show 
Keyboard 
Viewer’.

I bought my elderly 
mother an Apple 

Watch to help her stay safe 
as I heard that it can send 
out an emergency alert if 
she has a fall or gets into 
trouble. How is this done? 
Diana Campbell

All your mother has to do is 
hold the button on the side of 
the watch and the Power Off 
screen will appear that displays 
the ‘Emergency SOS’ option. 
If the button is continuously 
held down then the watch 
will automatically call the 
emergency services and send 
out details such as current 
location. The connected 
iPhone will also contact any 
emergency contact numbers.

Hold down 
the command 
keys to see the 
many symbols…

Genius Bar
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Is it possible to call numbers on my 
Apple Watch that aren’t listed in my 
contacts database? Fiona Moore

I have heard it is possible to play PlayStation 4 games on my Mac – can you 
please tell me how as I regularly have to surrender use of the TV? Duncan Hill

1 Download the app
Go to https://remoteplay.dl.playstation.
net/remoteplay/lang/en/index/html and 
then click on ‘Mac’ to download the PS4 
Remote Play app.

2 Set it up
Launch the app and you will be asked to 
connect your PS4 controller to your Mac 
via USB. Do so and then sign into your 
PlayStation account when asked.

3 Start playing
Once the setup process is complete you 
will be able to access your PlayStation 4 
interface through the app on your Mac 
desktop and start playing games.

 Access keypad
With watchOS 4, 
Apple has introduced 
a keypad that lets you 
dial a new number and 
make phone calls from 
scratch. It’s easy to use.

 Swipe up
You can activate the 
keypad whenever you 
are on a call by swiping 
up from the bottom of 
the Watch screen and 
tapping ‘Keypad’.

 Input numbers
If you need to input an 
extension then all you 
need to do is tap the 
relevant numbers and 
they will be sent to the 
phone system dialled.

 Extra keys
The keypad that 
appears when you are 
on a call will include 
two extra keys – star 
and hash – to help 
you navigate through 
automated systems…

It is indeed possible, but you will need to download the 
PS4 Remote Play app from the web to do so. Once you 
have downloaded the app the setup process can take a 
few minutes and involves connecting your PS4 controller 
to your Mac via USB and then pressing the PlayStation 

button on the controller to turn on your PS4 system and 
pair it with the app on your Mac (so make sure that your 
PS4 console is in range of the controller). When the setup 
process is complete you will be able to access your PS4 
interface on your Mac and play games as usual.
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Don’t forget that to make an emergency call on your Watch you can press 
and hold the side button and drag the Emergency SOS slider to the right.
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I have heard that it is possible to quickly scan 
documents in iOS 11. How is this done? Michael Perry

1 Open Notes
Open your Notes app and 
then create a new note and 
type a description of the 
document you are about to 
scan. Then press ‘+’.

2 Scan the doc
From the menu that 
appears, choose the ‘Scan 
Documents’ option. Then 
point your camera at the doc 
and follow the instructions.

3 Crop and save
When the document is 
scanned, crop out any 
unwanted background and 
then tap on the ‘Save’ option 
in the lower-right corner.

I was recently gifted an Apple Watch and I would like 
to make it more secure by adding a passcode. How 
would I go about doing this? Becky Tomkins

 Open the app
Making your Apple Watch 
more secure is all done 
through the Watch app 
on your iPhone. Open this 
app and then tap on ‘My 
Watch’ for a list of options 
relating to security.

 Unlock with 
your iPhone
For greater 
convenience you 
could have your Watch 
unlock whenever you 
unlock your iPhone. 
If this appeals to you 
then simply slide this 
option to the ‘On’ 
position and it will take 
effect immediately.

 Erase data
How many chances 
to crack open your 
device will you give 
a would-be thief? If 
you turn on this option 
then they will get 
ten attempts at your 
passcode before all of 
the data on the Watch 
is erased.

 Change your 
Watch passcode
There’s always the chance 
that someone can look 
over your shoulder as you 
tap in your passcode so 
it’s worthwhile changing it 
every so often. Tap on this 
option to do just that.

I am always on the lookout for
vintage items on eBay but hate 

the thought of missing out on 
something. Is it possible to get 
alerted whenever an item of interest 
is listed? John Gross

Certainly. In the eBay app, start off by 
performing a search for the items that you 
want to get alerts for and then, when all 
possible matches are listed, tap on the 
‘Save’ option at the top of the screen. 
You will then be able to type in a custom 
name for your search and if you enable 
the ‘Email alerts’ and ‘Phone alerts’ 
options you will be notified whenever 
new items that match the criteria are 
listed on eBay.

I was trying to show a friend a 
news story that I read through 

the News app on my iPhone a while 
ago but I can no longer find it. Is 
there a way to go back to stories that 
I have read previously? Sarah Jones

There certainly is. Open your News 
app and then tap on the option marked 
‘Saved’ at the bottom of the screen – 
even if, to your knowledge, you have 
never saved a news story. On this screen 
will be two tabs at the top: ‘Saved’ and 
‘History’ – tap on the latter and there will 
be a list of all of the news stories that you 
have tapped on.

Turn on ‘Email alerts’ and ‘Phone alerts’ to 
ensure you never miss an item on eBay…
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How do I turn on private 
internet browsing in 
Safari on my iPhone?
In Safari, tap on the tabs 
icon in the lower-right 
corner to display all open 
Safari tabs. Next, tap on 
‘Private’ in the lower-left 
corner (the interface 
should go dark) and then 
tap the ‘+’ icon to open a 
new private tab. To 
disable this, tap the 
tabs icon, close the 
private tab and then tap 
‘Private’ (the interface 
should go light). 

I have only had my 
iPhone 7 for six months 
but already my fully-
charged battery is dying 
in about two hours. How 
can I prevent this?
On your iPhone, go to 
Settings>Battery and you 
will be given a rundown of 
what apps and services 
have been draining your 
iPhone’s battery. You may 
also have certain apps 
open that refresh in the 
background, so check out 
the settings for apps such 
as News and then turn off 
the ‘Background App 
Refresh’ options.

How do I find out the 
serial number for my 
new iPhone? 
Go to Settings>General 
and you will see an option 
at the top of the page 
called ‘About’. Tap on this 
and all of the important 
facts and figures about 
your iPhone will be listed.

Apple 
Expert

After creating an invisible folder, click the name to rename it and press 
space three times to give it an invisible name. Remember where you put it!

A colleague told me you explained how to create an invisible 
folder on your desktop last issue. I tried to fi nd it but my 
newsagent had sold out – can you please share it again? Paul Yeo

1 Create a folder
Create a new folder on your 
desktop by going to File>New 
Folder or press Shift+Cmd+N. 
Call it what you want for now.

4 Copy and paste
Click on the blank screenshot 
and press Cmd+A again to 
highlight the space and then 
press Cmd+C to copy it.

2 Take a screenshot
Now take a quick screenshot 
of your desktop by pressing 
Shift+Cmd+3 and then double-
click to open it.

5 Get folder info
Now click on your new folder 
and press Cmd+I to ‘Get Info’. In 
the window that appears, click 
on the thumbnail at the top.

3 Delete the image
When your screenshot has 
opened in Preview, press 
Cmd+A ‘Select All’ and press 
Delete to make the image blank.

6 Paste image
With the folder thumbnail 
selected, press Cmd+V to paste 
the blank image over the top, 
thus making your folder invisible.
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A serious monitor for professionals, the PD3200Q is perfect for 
connecting your MacBook to and then exploring unparalleled levels of 

detail in design and photography. Absolute gold! 

BenQ PD3200Q  
Design Monitor   

£439/$459

Verdict

Boasting a 32-inch 2K display complete with
BenQ’s Vertical Alignment (VA) panel technology
to provide higher contrast and deeper blacks, the
PD3200Q is a great bit of kit if you need to delve
into detail. The sRGB and Rec.709 colour space
can be viewed from a wide angle and the monitor
also comes with an impressive array of modes for 
professional designers and photographers.

The Darkroom mode adjusts the brightness 
and contrast of images giving clarity and greater 
sharpness, ideal for working in darker, post-
processing conditions. On the other hand, CAD/
CAM mode provides greater contrast on lines and 
shapes, which is perfect for designers, architects 
and illustrators. The supplied puck controller lets 
you switch between the modes quickly and easily 
and you can also map additional functions to the 

buttons, such as brightness and contrast – it is 
flexible to a variety of requirements and setups.

The PD3200Q monitor is finely crafted to
provide the optimum in comfort and design. The 
display itself slots easily on the sturdy stand, on 
which it can be raised, lowered, tilted and pivoted 
into a myriad of positions – even vertically. The 
flicker-free, low blue light screen also means 
that you can burn the midnight oil on a pressing 
project without feeling general fatigue and eye-
strain as a result.

At nearly £500, the PD3200Q is a serious 
outlay, but the features and the crystal 2K QHD 
2560x1140 display more than justify it, especially 
if you need to see every ounce of detail. The 
only downside is the built-in speakers (they really 
shouldn’t have bothered).

The supplied puck controller lets you 
switch modes easily and you can also 
map other commands to the buttons

Connectivity to the PD3200Q
includes DVI, HDMI, DisplayPort, Mini 
DisplayPort and USB…

The monitor also supports SD/MMC 
type cards and accommodates audio-
in, though the speakers aren’t great…

Key features Learn more Available from

Reviews
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Not brilliant for music with limited connectivity and they look absolutely
hideous with wires spewing forth from everywhere! However, get over

the tacky looks and they handle game noises relatively well.

Edifier C2V  
Multimedia Speakers  

£112.99/$119.99

Verdict

If you’re after a wire-free, clean and versatile audio
setup then look away now because Edifier’s C2V
multimedia speakers may be the most wired
monstrosities you are ever likely to see. That
said though, they don’t come with Bluetooth
connectivity and aren’t designed to be a focal
point in the living room – these are speakers for
gamers in bedrooms. This is probably just as well
because hardcore gamers tend to live nocturnal
lives in dimly-lit conditions, where the C2Vs’
repellent looks become obscured by shadows.

This 2.1 speaker system features a 6.5-inch
subwoofer paired with two satellites, each
equipped with a 3-inch midrange and 3/4-inch
tweeter, all connected to a central amplifier.
Admittedly the sound produced, though not

ideal for music, is perfectly suited to games of all
genres, as you can quickly adjust the controls on
the amp to suit your needs – racing, adventure,
shooting, the sound can be quickly configured
to really bring your games alive and the volume
ramped up to make your room shake.

It’s just a shame that the build isn’t up to the
sound standard. The bow-tie-shaped amplifier
is ghastly and feels incredibly cheap and the
supplied remote feels like it dropped out of a
Christmas cracker. The woofer and satellite
speakers are better made in comparison, but
they don’t look great. For all the benefits of being
able to quickly tweak the sound configuration to
suit the game, we would rather just opt for an
alternate setup that looks as good as it sounds.

On the whole, the C2V multimedia
speakers aren’t likely to turn any heads
with their naff design…

The connection ports are in short supply
on the C2Vs, limited to just RCA and
AUX-in ports for mainly gaming…

Controls and an easily-grippable dial 
on the amp let you quickly change the 
sound to suit the game

Key features Learn more
edifier.com

Available from
amazon.co.uk
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A sleek, premium-looking unit that radiates rich sound around the room.
In fact, the quality of the audio produced here exceeds that of bars

nearly twice the price, making this a definite contender.

Q Acoustics M2 
Soundbase  

£299/$299

Verdict

While we understand that the traditional design
and dimensions for sound bars are for positional
purposes and wall-mounting, that doesn’t
disguise the fact that the majority of them are
just plain ugly. Aesthetically-speaking then,
Q Acoustics’ M2 Soundbase is much more to our
liking as it looks more like an authoritative sound
platform than a chunky bar.

Beneath the hood is a powerful 80W amp,
subwoofer and the real star of the show, Q
Acoustics’ unique Balanced Mode Radiator (BMR)
driver units. These essentially turn the entire
room into a listening ‘sweet-spot’ by dispersing
the sound 180 degrees around the area – but
obviously positioning is key to obtaining this
effect. The M2 unit itself can be positioned

under your TV or slotted easily into a cabinet to 
take audio prominence within the main room of 
your home and the minimalistic design gives it a 
premium, classy look despite the relatively cheap 
asking price.

The M2 utilises Bluetooth 4.0 as one of its 
many connection methods and pairing it with 
your Mac or iOS device simply requires you to 
tap the standby button on top of the unit until 
the surrounding light flashes the colour that 
corresponds to the connection method (in this 
case blue, obviously). With further connections for 
HDMI, Optical, USB and standard AUX, the M2 is 
a versatile beast that can slot easily into any home 
setup. Highly recommended if you want great 
sound without splashing out obscene amounts.

A simple set of controls on top of the
unit let you switch through the various
sources, including Bluetooth and HDMI

The included remote control feels a little
cheap compared to the quality of the
main unit, though it does the job…

The M2 is a versatile sound system and 
connections include Bluetooth, HDMI, 
USB, Optical and AUX-in

Key features Learn more Available from
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Decent only for relaxed listening, the unattractiveness of the headphones
adds to the disappointingly long list of drawbacks. There are many better

and cheaper alternatives to these earphones on the market.

ATH-CKR75BT 
Wireless Headphones  

£149/$159

Verdict

When producing a pair of wireless Bluetooth
earphones, it is the norm that a long battery
life should be of paramount importance.
Unfortunately, the ATH-CKR75BT headphones by
Audio-Technica do not offer this. One full charge,
which takes five hours, only provides the user
with seven hours of uninterrupted listening; barely
sufficient for a day out. In addition to this, the pair
of earphones are not the most attractive wireless
options out there by any means. A bulky unit
with a clip attached sits directly in the middle of
the cable that joins the two earphones together,
rendering the set extremely difficult to keep subtle
and discreet when out and about. The joining
wire is also flimsy and feels as if it can be easily
broken or damaged. Despite this, each individual

earphone is sleek, aesthetically pleasing and fits
comfortably in your ear.

Moving onto sound quality; the ATH-CKR75BT
Wireless Headphones are a mixed bag to say
the least. For relaxed, casual listening these
earphones are relatively good. Each sound has
a softness about it which makes the listening
experience enjoyable. However, there is an
obvious humming fuzz noise in the background
as soon as the earphones switch on until they
are turned off. The on-wire controls work fairly
well with the standard volume and play/pause
options. Unfortunately, however, when you use
these controls to change the volume there is an
overwhelming ‘beep’ noise that distracts from the
song you’re listening to.

The headphones feature in-line
smartphone controls with a mic for
managing music and calls

The earphones are constructed out
of lightweight machine aluminium to
reduce unwanted resonance…

The cable-clip can be attached to 
clothing for security and stability  
when out and about…

Key features Learn more Available from
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With a great contemporary design and a decent sound, the R1280DB
speakers are an absolute steal for the price. Sure the remote is cheap tat

and the facias are hideous, but everything else here hits the spot!

Edifier R1280DB 
Multimedia Speaker  

£119.99/$129.99

Verdict

With Optical, Coaxial and RCA/AUX connectivity,
Edifier’s R1280DB active bookshelf speakers
have the versatility to slot into any audio setup.
However, as Apple users, it is the ease with
which we can pair our Macs and iOS devices to
them that is of prime importance. Mercifully, after
powering the unit on it is simply a case of tapping
the Bluetooth button on the supplied remote and
they become instantly discoverable, enabling you
to connect within seconds.

The speakers measure in at 5.75 x 9.5” and
comprise of 4-inch bass units and silk dome
tweeters, and you can manage the EQ thanks to
onboard controls (located on the active/powered
speaker) that let you adjust the treble, bass and
volume. Available in either black or natural wood,
the speakers look best without their somewhat

naff-looking facias, but these easily detach to 
expose the pulsating, booming goodness behind. 

For the price, we really have to applaud the 
sound quality that the R1280DBs produce. With 
the volume set far too high when we initially 
turned them on, we were quite taken aback 
by the power that they produced – without 
noticeable buzz or distortion, it has to be said 
– and once we had lowered the output and 
tweaked the treble and bass controls we were 
able to achieve highly pleasing sonics for a variety 
of different styles of music. Like Edifier’s R1010BT 
speakers, these are perfect for connecting up to 
vinyl turntables for a great silky sound.

Certainly if you are on the hunt for a bargain 
set of decent-sounding bookshelf speakers then 
these come highly recommended.

You can adjust the EQ using the controls
located on the active/powered speaker
for treble, bass and volume

Connections include Optical, Coaxial,
RCA/AUX and, of course, Bluetooth –
and pairing is quick and easy

The speakers look best when you
remove the slightly tacky facias to
expose the goodness behind…

Key features Learn more
edifier.com

Available from
amazon.co.uk

Reviews
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Accessories
Saga  

Backpack
£59.95/$59.95

stmgoods.com
This attractive backpack is 

designed to hold a 15” laptop and 
has a suspended tech cell to keep 

your computer away from the 
impact zones. It also has plenty of 
compartments to carry the rest of 
your daily essentials and a reverse 

bucket opening provides quick 
and easy access to your gear.  
The Saga is available in four 
colours (including the regal-

looking Royal Purple, pictured 
here) and the spongy straps and 

carry handle make it a comfortable 
travelling companion.   

Adonit Pro 3 
Stylus

£25.99/$23.99
adonit.net

Wallet-friendly styluses don’t 
come much more responsive 
than Adonit’s Pro 3. Available 
in four colours (Black, Silver, 

Rose Gold and Midnight Blue), 
this lightweight piece of digital 
stationery is fashioned out of 

aluminium, has etchings on the 
shaft for improved grip, and also 

comes with a magnetic cap and a 
precision disc on the nib to create 
an accurate contact point on the 

screen. Highly effective for writing 
and drawing on your iPad.  

Reviews
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BoomBar+ 
£39.99/$49.99
kitsound.co.uk

Available in five different colours, KitSound’s 
BoomBar+ wireless speaker is very portable (a 

sturdy loop band makes it easy to attach to a belt 
or rucksack) and very easy to pair with your Mac or 
iOS device (just turn it on and it can be discovered 
immediately). Of course, it’s very rare in the titular 
portable speaker market to experience a sound 

quality that’s really worth crowing about but, for its 
size, this produces plenty of volume. The unit comes 

with a microUSB charge port and AUX-in. 

Augmented Reality Gun
£19.99/$19.99

prezzybox.com
As AR apps are all the rage at the moment, this 

wooden accessory helps you take the experience 
a step further and setting it all up is simple. After 
inserting two AAA batteries into the compartment 
on the underside of the gun, you can then scan a 
QR code to download the AR Gun app, hold the 
trigger to fire up the gun and then while away the 

hours blasting away spacey things layered over a live 
camera feed on your iPhone (that snaps snugly into 
the clip on top of the gun). Great fun for a little while.

Flex Arc Wireless  
Neckband Earbuds

£34.99/$34.99
zagg.com

Lightweight and very flexible to your needs, iFrogz’s Flex Arc 
in-ear headphones come with a neckband with two weighted 
tips to keep it in place on your shoulders. One of these tips 

houses a simple set of controls for controlling your music and 
answering calls. Protruding from the neckband are two super-

skinny cables leading to a pair of attractive earbuds. Each 
earbud houses an 8mm driver and the rear ends are magnetic 
so that they clip together when not in use. They produce good 
sound and noise-cancelling tech blocks out everything else.
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An intuitive and well-realised suite of tools for mapping out your mind.  
After two weeks though it struggles to justify the price. 

MindNode 5
£38.99/$38.99

Verdict

Requirements 

Learn more 
https://mindnode.com

Available from 
Mac App Store

If you have a naturally scrambled mind that 
struggles to form cohesive thoughts then 
MindNode 5 is perfect for helping you get all of 
your ideas down into some sort of structure. Your 
map starts with a single word or phrase and you 
can add illustrative art from a stock menu, check-
list tick boxes to each node and even your own 
photos. If you then hover your cursor to the side 
of your initial word, a ‘+’ icon will appear that you 
can click on to add a connecting word, and so on 
until your map starts to take shape…

You can add as many connecting words as 
you want and then branch off from them into 
sub-menus to gradually map out even the most 
complex of thought processes. It’s very intuitive 
to use and you can really go to town styling up 
your mind maps thanks to a formatting menu. 
In fact, the interface is so similar to Apple’s own 
iWork apps (Pages, Numbers and Keynote) that 

you’ll soon get the hang of things here if you are 
familiar with the interface of those apps. Other 
icons allow you to add extra lists of notes to your 
maps and share them with other people, and by 
clicking on the themes icon in the top-left corner 
you can change your canvas colour and pick a 
different node style for your map. The only thing 
missing is some sort of menu bar functionality so 
that you can access and add to your maps when 
inspiration strikes.

Although the app is free to download, the trial 
only lasts for two weeks, thereafter the full suite 
of options will cost you £38.99 to unlock. Despite 
being a useful tool for planning projects and 
uncluttering your mind, we do feel that the asking 
price is a little too steep. While we applaud how 
well the subject matter has been realised and 
implemented, we’re not convinced that there is 
enough here to warrant the high cost.

Start mapping

Adding notes

Formatting tools

“You can map 
out even the 

most complex 
of thought 
processes”
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Once you settle in, Tacoma won’t take you very long to complete, but the five or so hours 
of gameplay on offer deserve to be savoured and played at a casual pace.

Tacoma
£19.99/$19.99

Verdict

Requirements 

Learn more 
https://tacoma.game

Available from 
Mac App Store

An investigation into the fate of the crew members 
onboard a space station, Tacoma is a unique 
and gripping adventure game that makes you 
feel utterly unnerved the moment you enter the 
stricken vessel. The deserted passageways and 
rooms hold many ghosts of the past in the form of 
holo recordings of pivotal moments that you can 
play back to see what information and possible 
clues they may hold. This is where the game takes 
a detour from the usual point-and-click adventures 
because these recordings chart the conversations 
and movements of numerous people within the 
same scene and concentrating on someone in 
one area may mean that you miss something vital 
at the very same moment in another area. You 
have the ability to fast forward and rewind these 

holo tapes but the real beauty of the game soon 
becomes very apparent – you actually have to 
think for yourself and approach it like a proper, 
fully-fledged investigation.

As you traverse the barren space station, you 
can pick up and examine inanimate objects, 
consult your AR interface for additional information 
and interact with pretty much anything. It’s good 
to know that there is no combat in the game as 
that suggests that you are free from confrontations 
that, coupled with the detachment and isolation 
you feel when playing, would probably have sent 
you over the edge. Instead there is just a gripping 
and, at times, very emotional, story being played 
out from the past that you can’t help but get 
completely immersed by.

Ghosts of the past

together the mystery surrounding 
the Tacoma crew’s fate

Atmospheric surrounds

Dead pool
You can interact with seemingly 

anything – you can even shoot some 

“A gripping 
and, at times, 

very emotional 
story that you 
can’t help but 
get completely 
immersed by”
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